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CHAPTER 1

Introduction

This user guide provides an overview of the MIMIC software product, a powerful research tool that
incorporates a multitude of market-specific features into a logical, user-friendly platform. The information in
this guide introduces the basic functional components of the software interface in an easily-accessible format
for users of all skill levels.

MIMIC also features a context-sensitive help system that references the help topics in this guide. To use
this system, users can select the  button in the MIMIC toolbar, and then select the appropriate MIMIC
component to quickly locate related information.

Installation
For instructions on installing the MIMIC application, see the “MIMIC Installation and Purchase Options”
chapter in the Client Application Installation Guide.

MIMIC Research Capabilities
MIMIC is a powerful research tool that incorporates a multitude of market-specific features into a logical,
user-friendly platform. Users can easily perform complex market-specific evaluations, and create custom-
tailored output using the following MIMIC functionalities:

Functionality Description
Charts and Tables MIMIC's advanced charting capabilities create superior charts and tables on the fly. Set trendlines,

zoom into specific areas and perform updates with ease. Tables can be exported to Microsoft
Excel®. The summary statistics at the bottom of the table provide useful information, such as
average price for the period, maximum and minimum prices, standard deviation and the last
closing price.

Seasonal Analysis MIMIC allows you to create seasonal analysis studies in which the price history of a commodity
can be charted over several years on a single chart.

Forward Curves Use MIMIC’s forward curves functionality to chart today’s market estimate of the price of a
commodity at various points out into the future. View multiple curves in MIMIC for a particular
commodity and see the underlying future series in the same chart.

Units and Currency Conversion MIMIC allows you to compare different commodities by first establishing a common unit of
quotation.

http://www.lim.com/pdfdocs/install_limapps.pdf#MIMIC_Installation_and_Purchase_Options
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Functionality Description
Search Functions The extensive data in the MIM database can be searched using the Search Database button to

locate symbol names and descriptions or by drilling down into folders using the Tree View feature.

Formulas Perform arithmetic computations using the MIM Formula Library that includes technical studies,
such as correlation, rsi, macd and moving averages to name a few.

MIMICExcel Run MIMIC from within Excel (MIMICExcel), providing all the functionality of MIMIC while working
in the Excel environment.

7-day & Intraday Data The MIM database contains 7-day, intraday and tick data values. Event date files are also
available.

For more information on MIMIC, click the "Documentation" link on the LIM Web site
( www.lim.com).
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CHAPTER 2

MIMIC Configuration Window

The MIMIC interface, or the MIMIC Configuration window, allows users to enter and view query
information. It is organized into two distinct areas: the Worksheet (the upper portion of the window) and the
Data Builder (the lower portion of the window).
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The Configuration window includes the following main components:

Component Function
Title Bar Displays the software name and server/port number in brackets.

Menu Bar/Toolbar Provides primary access to MIMIC’s functions and commands, such as saving a worksheet,
opening a saved worksheet, or printing a table or chart. The menu bar includes menus and menu
options and the toolbar includes toolbar buttons.

Tabs Provides data functionality based on the selected tab: MIMIC, Stored Formulas, or Screening.

The Stored Formulas and Screening tabs require an additional fee for activation.

Worksheet Toolbar Includes buttons with functions specific to the Worksheet.

Worksheet Includes a record of the data series or formulas that were constructed using the Data Builder.

Data Builder Allows user to create a detailed query. Includes the following tabs: Series, Formula, Curve and
Forward Curve.

MIMIC Toolbar
The buttons in the MIMIC toolbar allow users to quickly access a commonly-used MIMIC function. The
MIMIC toolbar includes the following buttons:

Button Name Function
New Opens a new worksheet.

Open Opens an existing worksheet.

Save Saves a worksheet.

Print Prints a chart or table.

Configuration Returns to the Configuration window from a chart or table.

Chart Creates a chart from a worksheet.

Table Creates a table from a worksheet.

Refresh In a chart or table, select the Refresh button to update the data view.

Help Opens the MIMIC content-sensitive help.
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Worksheet Toolbar
The buttons in the Worksheet toolbar allow users to manage rows within the Worksheet. The Worksheet
toolbar includes the following buttons:

Button Name Function
Add Row Adds a new row to the bottom of the Worksheet.

Insert Row Inserts a row above the selected row.

Remove Row Removes a row from the Worksheet.

Add Contracts Adds a new contract. Users can specify a date range (month and year) and the contracts
automatically display in the Data Builder. If users check Add Seasonal Contracts, MIMIC adds
all the contracts for the entered months/years seasonally in the Data Builder.

Add to Favorites Saves commonly-used relation and column names in the Data Builder.

Favorites Displays the relation and column names saved in Favorites.

The Add Contracts  button is disabled until users add a futures contract to the Data Builder.

The Worksheet
The Worksheet constitutes the top portion of the Configuration window, above the Data Builder and below
the Worksheet toolbar. The Worksheet displays any query information constructed in the Data Builder.
MIMIC displays this query information displays in columns in the Worksheet.

The Worksheet contains the following column headings.

Column Function
Label Indicates the row as assigned by the system.

Description Indicates a description of the entered symbol.

MIM Symbol Indicates the MIM symbol.

Column Indicates the column.

Time Units Indicates the time unit.

Units Indicates the units of measure.

Chart Type Indicates the chart type. Options include Line, Bar, Baseline, and Invisible.

Formula Indicates the formula entered under the Formula tab.

Rollover Policy Indicates the rollover policy that was edited in the Data Builder.
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Users can create a new worksheet row by using the Add Row  button. Any subsequent query information
entered in the Data Builder (symbol name, column, units, etc.) appears in the new row.

Worksheet Shortcuts
MIMIC includes several Worksheet shortcuts. Users can copy and paste rows using keyboard shortcuts, or
use the Worksheet right-click menu to copy, paste, insert or delete a row. Users can also reposition rows using
keyboard shortcuts, and synchronize the Column and Time Unit columns.

Copy/Paste Options, Right-Click Menu and Repositioning Rows
MIMIC users can use either the keyboard or the right-click menu to copy and paste a row. Users can also use
the right-click menu to insert or delete a row.

● To copy/paste a Worksheet row using keyboard shortcuts, users select a row, and select Ctrl+C from the
keyboard to copy, and then Ctrl+V to paste the row. The row pastes below the selected row.

● To copy/paste a Worksheet row using the right-click menu, users select a row, right-click and select Copy,
and then right-click again and select Paste. The row pastes below the selected row.

● To insert or delete a row using the right-click menu, users select a row, then right-click and select Insert or
Delete. MIMIC inserts a new row above the selected row.

Users can also insert or delete a row by clicking the Insert Row  button or the Remove
Row  button on the Worksheet toolbar.

● To reposition or re-order a row, users can select any cell within the row, and then use the Ctrl + the up
arrow or the down arrow Up Arrow/Down Arrow to move the row accordingly.

Synchronization of Columns and Time Units
Symbols may contain different Column and Time Units entries. Users can set or synchronize all rows in a
worksheet to have the same Column or Time Units entries.

Users can only synchronize the Column and Time Units entries in MIMIC.
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For example, a worksheet contains symbol and information for HO (row 'A') and for NG (row 'B'). The
Time Units for HO are set to Daily and the Time Units for NG are set to Weekly. In this example, users
can set or synchronize the Time Units entries to Daily or Weekly for both Worksheet rows.

● To synchronize the Column entry, in a Worksheet row, users select the Column entry, right-click and then
select Set all Columns to X, where X represents the setting, such as Close or Bar.

● To synchronize the Time Units entry, in a Worksheet row, users select the Time Units entry, then right-
click and select Set all Time Units to X, where X represents the setting, such as Daily or Weekly.

Data Builder
The Data Builder constitutes the lower portion of the Configuration window, below the Worksheet.
The Data Builder allows users to search for MIM symbols, set date and worksheet options, create custom
formulas, and load curve and forward curve data. The  Series ,  Formula ,  Curve  and  Forward Curve 
tabs, as shown below, control the different MIMIC query functionalities:

The Data Builder's Search Database functionality allows users to perform detailed database searches
for specific symbols (for more information, see Chapter 10, “Searching in MIMIC”). When a symbol is
selected, its descriptive information, such as MIM symbol name, column and unit type displays by row in the
Worksheet. The icons at the left side of the Worksheet indicate the type of query used for each symbol, either
a series, formula, curve or forward curve:



8
 

MIMIC USER GUIDE
Chapter 2: MIMIC Configuration Window



MIMIC USER GUIDE
Chapter 3: Menu Options

9
 

CHAPTER 3

Menu Options

The Configuration window includes the following menu options: File, Edit, View, Options, Tools and
Help.

File Menu 
The File menu includes the following options:

Option Function
New (Alt+N) Opens a new worksheet.

Load (Alt+L) Opens an existing worksheet.

Save (Alt+S) Saves a worksheet.

Save As Saves an existing worksheet with a new name.

Import Symbols Imports symbols from the following type files: .llc, .csv or .txt. Files of type .csv and .txt must be
in the format: SYMBOL,[COLUMN] where COLUMN is optional. If the column is omitted, then the
default column for the symbol is used.

Export Symbols Exports all symbols and columns contained within a worksheet to a file with the format
SYMBOL,COLUMN. The file may be saved as a .txt or .csv file.

XML Converter Use Save Current Worksheet as XML to save current MIMIC worksheets in XML format (.xml).
Users can also convert existing MIMIC worksheets (.llc files) to XML using the Convert Existing
Sheets option.

Print Chart Prints a chart.

Print Table Prints a table.

Save Chart As Saves an existing chart with a new name.

Save Table As Saves an existing table with a new name.

Exit Exits the MIMIC application.
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Edit Menu 
The Edit menu includes the following options:

Option Function
Cut/Copy/Paste Use the Copy command to copy charts and table data into other applications.

Add Row (Alt+A) Adds a new row to the bottom of the Worksheet.

Insert Row (Alt+I) Adds a new row above the selected row.

Remove Row (Alt+R) Removes a row from the Worksheet.

View Menu 
The View menu includes the following options:

Option Function
Chart Options Grid - Displays gridlines on a chart.

● Symbols - Displays the symbol. This helps when printing charts in black and white, so users
can distinguish between symbols.

● Controls  - Displays the chart controls at the bottom of the Chart window. Controls include
Trendlines, Mouse Pick, and Zoom.

● Legend  - Displays the legend.

● Legend Anchor - Enables the legend anchor. Options include North, East, South and West.

● Legend Orientation - Enables the legend orientation. Options include Vertical and
Horizontal.

Configuration Returns users to the Configuration window.

Chart Displays the Worksheet data in a chart.

Table Displays the Worksheet data in a table format.

Query Displays the XMIM query language.
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Options Menu 
The Options menu includes the following options:

Option Function
Color Print When checked, uses the colors defined in the Color Configuration option (Options>Color

Configuration).

Mixed Case Symbols Allows the user to type in lowercase and have the letters appear uppercase in the Symbol field.
This is convenient when entering symbols into the MIM Symbo l field as symbols must be entered
in uppercase.

Server Config Defines the server, port number and server type. You must restart the application for the changes
to take affect.

User Preferences For a detailed description of the different User Preferences options, see Chapter 9, “User
Preferences”.

Color Configuration Change the color options for charts for printing and on-line viewing.

Axis Font Change the font type for the chart axis display.

Tools Menu 
The Tools menu includes the following options:

Option Function
Curve Matrix When a futures symbol is entered into a worksheet, the Curve Matrix menu option becomes

accessible. Use this feature to create a .csv file (opens in Excel) showing the futures contracts by
value or contract name for a specified date range.

Validate Formulas Validates formulas created under the Stored Formulas tab, and notifies users if a formula
becomes broken.

Help Menu 
The Help menu includes the following options:

Option Function
About Displays MIMIC release and copyright information.

Java Console Displays communication between MIMIC and the MIM server in a Java console window. Used for
troubleshooting purposes.

MIMIC Help Opens the MIMIC Help.
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CHAPTER 4

Series Tab – Data Builder
The Series tab is the first tab in the Data Builder. MIMIC represents a series in the Worksheet with the
Series  icon.

The Series tab in the Data Builder includes the following options:

Option Function/Description
Symbol Displays the symbol name. User can enter the symbol name (or use the Search Database 

button), and then press or select Enter to populate the symbol information in the Worksheet.

Column Indicates the data series that relates to the symbol. Every symbol name has a list of associated
columns and a default column. Users can select the pull-down for different Column options

Description For a series or curve, displays the description of the symbol. The description name for a series
is in the format: exchange: symbol description (units): session. For a formula, users can enter a
description.

Time Units Indicates the unit of measurement that the series is quoted in.

Units Indicates the default units of quotation associated with a symbol.

Use Indicates a pull-down option that allows users to select different units of quotation for a symbol.

Factor Overrides the units of measure conversion factor.

Edit Allows users to change the conversion factor number.

Lock Allows users to lock the unit of measure for a symbol to the same unit of measure as a previously
entered symbol when conversion factors are available.

Show in Table/Show in Chart Displays the results for the selected row in a table or chart. These options are selected by default.
If not selected, the row in question will not be included if users selected the Table  button or
the Chart  button from the toolbar.

Chart Type Sets a chart type for the results. Options include Bar, Chart, Line, or Invisible. The Invisible
setting does not chart the selected row.

Chart Label Indicates a title or label for the a chart.

Precision Indicates the number of decimal places that the series will be quoted in. Users can select the pull-
down for a value between zero and eight.

Adjust Contract Allows users to override default settings for contract rollover policies when using futures-type
data. This setting also allows users to instantly determine which “relative” contract of a futures
contract to display or analyze. The default is “prompt (front),” meaning the nearest contract to
expire at any point in time. Use the associated pull-down list to select the number of contracts out.

Note: The Adjust Contract option only allows users to select which relative option is displayed. If
you want to specify the rollover policy and expiration date policy for futures, users can select the
Custom Contract option.

Custom Contract/Edit Rollover Allows users to determine the futures contract used for creating a custom continuation futures
series.
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Option Function/Description
Edit Chart Stats Allows users to display the maximum, minimum, average, last or standard deviation in a chart. By

checking the Apply to All Items box, users can keep the selections for any future items that are
added.

Custom Contract/Edit Rollover
The Custom Contract/Edit Rollover options allow users to determine the futures contract used for
creating a custom continuation futures series. The default selection for futures in MIMIC is usually the
parent contract (e.g. “CL” NYMEX Light, Sweet Crude Oil) which always returns the CL contract closest to
expiration, changing or rolling over to the next contract on the day the closest contract expires.

 The Adjust Contract option allows users to change from the contract closest to expiration to one relatively
further out. For example, “prompt + 1” looks at the contract one further away from expiration than the
prompt. The Custom Contract option allows users to make complex adjustments to the handling of the
change-over between contracts, usually with the intention of smoothing over any price differences between
the old and new contracts. With the rollover date functionality, users can also adjust the date on which the
rollovers between contracts occur.

MIMIC offers a number of presets and custom selections under the Custom Contract/Edit
Rollover option. Expert users may prefer to use the query statements under the Rollover
Preview section of the Edit Rollover window. For more information on rollovers, see the 
Rollovers guide in the "Documentation" section of the LIM Web site (www.lim.com).

Setting Custom Contract / Edit Rollover Options
Users can open the Edit Rollover window to set custom contracts and edit rollover options.

To open the Edit Rollover window, complete the following steps:

1. In the Data Builder, enter a symbol and press Enter.

2. Check Custom Contract.

3. Select the Edit Rollover   button. The Edit Rollover window displays:

http://www.lim.com/pdfdocs/rollover_orig.pdf
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The different tab options include Presets, Rollover Date, Date Offset, Expiration, Prices and
Modify Prices.
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Presets 
MIMIC includes the following Presets options in the Edit Rollover window:

Option Function/Description
Volume Crossover Allows users to define when the volume is greater in the next contract. Many traders believe the

best time to roll is when the volume becomes greater in the next contract (volume crossover)
because this usually means the following contract is the more liquid contract.

Open Interest Crossover Allows users to define when the open interest is greater in the next contract. Many traders believe
the best time to roll is when open interest becomes greater in the next contract (open_interest
crossover) because this usually means the following contract is the more liquid contract.

Backwards Adjusted Prices Allows users to perform a backwards adjustment on prices from the list of presets. The main
difference between backward adjusted and forward adjusted is that the current contract is
unadjusted. This means that the previous history is adjusted by the difference between the new
contract and the current contract. After the roll occurs the most current contract is the same as
actual prices; however, the past prices will be adjusted (and can become negative).

# Day(s) Before Expiration Allows users to control when the contract will roll before expiration.

Rollover Date 
MIMIC includes the following Rollover Date options in the Edit Rollover window:

Option Function/Description
Last Data Day Rolls the contract on the last day that there is data for the symbol.

First Notice Day Not currently available; however, in case the need arises, this functionality has been added to the
MIMIC interface.

Expiration Day Rolls the contract on the expiration day.

Expiration Month Rolls the contract on a specific day in the expiration month.

Volume Crossover Defines when the volume is greater in the next contract. Many traders believe the best time to roll
is when the volume becomes greater in the next contract (volume crossover) because this usually
means the following contract is the more liquid contract.

Open Interest Crossover Defines when the open interest is greater in the next contract. Many traders believe the best
time to roll is when open interest becomes greater in the next contract (open_interest crossover)
because this usually means the following contract is the more liquid contract.

Date Offset 
Users can select the Date Offset option in the Edit Rollover window to specify when the contract rolls
relative to the expiration date.
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Expiration
Users can select the Expiration option in the Edit Rollover window to select the month that the contract
expires.

Prices
MIMIC includes the following Prices options in the Edit Rollover window:

Option Function/Description
Actual Prices Displays the actual prices of the historical series. The advantage is that the prices shown are the

actual ones traded. However, large gaps can appear in the series because of the difference from
one contract to the next during the roll. This type of gap can cause spikes in some “momentum-
type” technical indicators, which is misleading in most cases.

Adjusted Prices Indicates the adjusted prices. Options include Forward, Backward and Cash. All three of these
options eliminate possible gaps, which occur when rolling from one contract to the next; however,
each accomplishes this in a different manner.

Basics of Adjusted Prices:

For Forward Adjusted Prices, the adjustment takes place each time the contracts roll forward by
taking the difference between the closing price of the current contract and that of the new contract
(on that day) and then adjusting by subtracting the difference from all prices (Open, High, Low,
Close) throughout the new contract.

Note: Users cannot define when the forward adjustment starts. Forward adjustment takes place
from the beginning of the entire data series.

Backward Adjusted Prices Indicates the backward adjusted prices. The main difference between backward adjusted and
forward adjusted is that the current contract is unadjusted. This means that the previous history
is adjusted by the difference between the new contract and the current contract. After the roll
occurs, the most current contract is the same as the actual prices; however, the past prices will be
adjusted and can become negative.

Cash Adjusted Prices Indicates the cash adjusted prices and removes the gaps by raising or lowering the price levels,
so that the closing and cash correspond. The difference between the current contracts daily close
and the cash prices is subtracted from each day’s daily bar.

Perpetual Indicates a perpetual policy. Users must define a certain set time period. The example below uses
three months as the set time period.

3-Month Linear Perpetual Example:

If users define the time period as three months, then the perpetual policy analyzes three months
into the future to pick two contracts that are involved with the calculation. The first contract is the
contract that expires just before the 3 months. The second contract is the contract that expires
the soonest after the 3 months. Basically, the two contracts will form a bracket around the date
(the last contract that expires before the time frame and the contract that expires soonest after the
time frame).

Then, MIMIC counts the number of days to the expiration day for each contract. MIMIC uses
these two counts as weights in the perpetual calculation. The first weight is the number of days
from the first contract’s expiration to the set date in the future. The second weight is the number
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Option Function/Description
of days from the set date in the future until the second contract’s expiration. The closer the first
contract is to expiration the less it is weighed in the calculation. The perpetual policy can define
the calculation in three ways: Linear, Logarithmic, or Geometric.

(x1 = contract 1) (x2 = contract 2)
(w1 = # of days from expiration to set date in the future for contract 1)
(w2 = # of days from set date in future until expiration day for contract 2)

Linear: 

Logarithmic: 

Geometric: 

Smoothed Allows users to average many consecutive contracts at once. There are three ways to calculate
this average: Linear, Logarithmic and Geometric.

Linear: 

Logarithmic: 

Geometric: 

For example, if users want to create a series from three of the most current contracts while using
the linear smoothing function, then the policy must be similar to the example below.

3-Contract Linear Smoothed Example:

The calculation above would look like “(front + back + far) / 3”, depending on the rollover date.
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Modify Prices 
MIMIC includes the following Modify Prices options in the Edit Rollover window:

Option Function/Description
Top Section Allows users to specify which contract to use (i.e. front, back, far). The nearby modifier can also

specify the front, back, or far contracts.

Refers to the front contract:

● ROLLOVER_POLICY=”1 nearby, Actual Prices”

Refers to the back contract:

● ROLLOVER_POLICY=”2 nearby, Actual Prices”

Refers to the far contract:

● ROLLOVER_POLICY=”3 nearby, Actual Prices”

Middle Section Allows users to roll from one contract to the next contract for a specified length of time. Users
can interpolate the series for any number of days before the ROLLOVER_DATE. The interpolate
modifier uses the number of days until expiration as an important weight. This means the farther
away the contract is from rolling the more weight is placed on the current contract.

Bottom Section Allows users to create Gann-style continuous contracts. The Gann-style continuous contract rolls
from one contract to the next contract of the same month (i.e. for the next year).

The statement below creates a series that rolls from the March contract into the following years
March contract:

● ROLLOVER_POLICY=”March, Actual Prices”

The statement below uses the nearby modifier in combination with the year-to-year modifier.
MIMIC creates the series with the “back” April contract, and it rolls accordingly (when the front
contract expires).

● ROLLOVER_POLICY=”2 nearby, April Actual Prices”

Edit Chart Stats 
Users can select the Edit Chart Stats  button in the Data Builder to open the Stat Config
window and display the Maximum (Max), Minimum (Min), Average, Last or Standard Deviation (Std Dev) for
a chart. Checking Apply to All Items applies the selections for any future items that are added.
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CHAPTER 5

Formula Tab – Data Builder

The Formula tab is the second tab in the Data Builder. MIMIC represents a formula in the Worksheet with
the Formula  icon.

The Formula tab in the Data Builder includes the following options:

Option Function/Description
Formula Allows users to create a formula from the labels representing each series. A formula is written in

algebra using the basic operators: +, -, *, and /. For example, to subtract row 'B' from row 'A' (or A
– B).

Description Indicates the description of the formula. The description displays in the legend for the chart and
under the Column heading for the table.

Show in Table Displays the results of the selected row in a table.

Show in Chart Displays the results of the select row in a chart.

Chart Type Indicates a line chart, bar chart, or anchor a symbol as a baseline in a chart. The Invisible setting
means that MIMIC does not chart the selected row.

Chart Label Indicates the chart label displays in the legend of the chart.

Precision Indicates the number of decimal places that the series will be quoted in.

Edit Chart Stats Displays the maximum, minimum, average, last or standard deviation in a chart. Checking Apply
to All Items applies the selections to any future series.
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CHAPTER 6

Curve Tab – Data Builder

The Curve tab is the third tab in the Data Builder. The MIMIC Curve tab allows users to chart futures as a
forward curve by extracting information from the LIM database about the expiration dates and quoted prices
for a futures contract and transforming that data into a forward curve. The forward curve can display curves
for different dates on the same chart with the underlying prompt month contract. MIMIC represents a curve
in the Worksheet with the Curve  icon.

For information on forward curves, see Chapter 7, “Forward Curve Tab – Data Builder”.

The Curve tab in the Data Builder includes the following options:

Option Function/Description
Symbol Indicates the symbol name. Users select the Enter   button to populate the symbol information

in the Worksheet.

Description Displays a description of the symbol. The description name for a series is in the format: exchange:
symbol description (units): session.

Column Indicates the data series that relates to the symbol. Every symbol name has a listed of associated
columns and a default column.

Chart Label Indicates the chart label, which MIMIC displays in the legend of the chart.

Curve Date Indicates the date for the curve. Users can check Last Data Date to apply the last data date, or
select the Calendar button to choose a date from the calendar.

Edit Chart Stats Displays the maximum, minimum, average, last or standard deviation in a chart. Checking Apply
to All Items applies the selections to any future series.
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CHAPTER 7

Forward Curve Tab – Data Builder

The Forward Curve tab is the fourth tab in the Data Builder. The Forward Curve tab allows users to
retrieve, analyze and display data that has a forward dimension, including futures data. MIMIC represents a
forward curve in the Worksheet with the Forward Curve  icon.

The Forward Curve tab in the Data Builder includes the following options:

Option Function/Description
Category Indicates the category of a forward curve. Users must include the entire path in the Category

field. Users can select the Search Database  button to choose the desired category, or folder,
and then select the “+” to open the folders. Users can then right-click on the folder and choose
Select to add the folder to the Category field. The entire path displays in the Category field.

Column Indicates the column that relates to the symbol. Every symbol name has a list of associated
columns and a default column. Users can select the pull-down to select a column or select the
Search Database  button to enter a symbol and a column.

Description Indicates a description of the symbol. The description name for a series displays in the format:
exchange: symbol description (units): session. Users can enter a different description.

Show in Table Displays the results for the selected row in a table.

Show in Chart Displays the results for the select row in a chart.

Chart Type Indicates the chart type. Options include Line, Bar, Baseline, Invisible. MIMIC does not chart a
series with the Invisible setting.

Chart Label Indicates the chart label, which displays in the legend of the chart.

Precision Indicates the number of quoted decimal places for the series.
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Forward Curve Parameters
The Forward Curve tab in the Data Builder includes the following forward curve parameters:

Parameter Options/Description
Date None (no date entry)

Date (enter a date or select the Calendar button to select a date)
Date w/Time

Users can select either Today for today’s date, or Expiration for the expiration date, or users can
select the Calendar button to select a date.

Aggregate None
Daily Average
Daily High
Daily Low
Monthly Average
Monthly High
Monthly Low
Quarterly Average
Quarterly High
Quarterly Low

Fill None
Fill Forward - Uses the last valid value in the series and copies it forward, eliminating the NaNs
until the next valid value occurs.
Fill Backward - Uses the first valid value after a run of NaNs and fills the value back in time to
the previous valid value.
Fill Linear Interpolation - Creates synthetic values for the span of NaN values based on the last
known value and the next known value by creating linear interpolated values between them.

Formula:

x1 = last known value

x2 = next known value

w1 = # of days from x1 to the missing date

w2 = # of days from x2 to the missing date

Examples:

Without Fill Interpolate Linear:

Date Day 1
09/02/2001 Sun 11.7500
09/03/2001 Mon NaN
09/04/2001 Tue NaN
09/05/2001 Wed NaN
09/06/2001 Thu NaN
09/07/2001 Fri 17.0000

With Fill Interpolate Linear:

Date Day 1
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Parameter Options/Description
09/02/2001 Sun 11.7500 --- x1
09/03/2001 Mon 12.8000
09/04/2001 Tue 13.8500
09/05/2001 Wed 14.9000
09/06/2001 Thu 15.9500
09/07/2001 Fri 17.0000 --- x2

For 9/03/2001:

x1 = 11.75
x2 = 17
w1 = 1 (# of days missing date is from the first value)
w2 = 4 (# of days missing date is from the second value)
9/03/2001 = (11.75*4 + 17*1)/5 = 12.8
9/04/2001 = (11.75*3 + 17*2)/5 = 13.85

Fill Up - Fills from generated curve, same position for a previous day/year. If value found at
this generated curve is NaN, MIMIC does not proceed to find a value past four generated
curves. This is the limit set. For example, if there are forward curve values for June 20th, the
“fill up” value is the value found on June 19th. If a NaN is in this location on June 19th, MIMIC
generates the curve for June 18th. We will go back 4 days only.

The reason MIMIC limits the search for a non NaN value is because we do not know how many
days back we will have to search for a non NaN value. Same is true for monthly and quarterly
values. If there is a NaN value for the January 2001 monthly average, MIMIC can fill upward
from the January 2000 monthly average. If there is a first quarterly average of 2001 that was
a NaN value MIMIC can fill upward from the first quarterly average of 2000. The value MIMIC
retrieves several days/years ago may not have any meaning to this curve and therefore a limit
of four curve generations is in place.

Fill Down - Fills from a generated curve, same position for the next day/year. If the value found
at this generated curve is NaN, MIMIC does not proceed to find a value past four generated
curves. There is a limit set. For example, if there are forward curve values for June 20th, the
Fill Down value is the value found on June 21st. If a NaN is present, users can look up to June
24th, but then stop if we cannot find a value.

The reason it is necessary to limit the search for a non-NaN value is because it is not evident
how many days forward you will have to search for a non-NaN value. Same is true for monthly
and quarterly values. If there is a NaN value for the January 2001 monthly average, users can
fill downward from the January 2002 monthly average. If users have the first quarterly average
of 2001 that was a NaN value, users can fill downward from the first quarterly average of 2002.
The value users retrieve several days/years ago may not have any meaning to this curve, and,
therefore, a limit of four curve generations is in place.

Fill Vertical Interpolation - Takes an average from two generated curves to fill in the missing
data for our curve. If users look at a NaN value in our forward curve for Wednesday June 20th
at 10:00am which has a M-F trading pattern, users take the average of the values stored on the
forward curves of up to Thursday June 14th and Tuesday June 26th. If one of these values is a
NaN, then MIMIC stores the non-NaN value in the generated forward curve.

If both values are a NaN, users can leave the generated forward curve with a NaN value since
MIMIC was unable to generate a value. Same is true for monthly and quarterly values. If there
is a NaN value for January 2001, users can take the average of the January 2000 and January
20002 results. If there is a first quarter average of 2001 and it was a NaN, users can generate
a result from the first quarter average of 2000 and 2002.
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Parameter Options/Description
Units Days

Hours

Period Multiple selections are available and change the subsequent criteria for the Period setting.

Offset Number of offsets (using list)
Minutes, hours, days, weeks, months, quarters, years
Later, ago, before



MIMIC USER GUIDE
Chapter 8: Date Options and Worksheet Options – Data Builder

29
 

CHAPTER 8

Date Options and Worksheet Options –
Data Builder

The Date Options and Worksheet Options appear in separate panes at the bottom of the Configuration
window and are part of the Data Builder.

The Date Options pane in the Data Builder includes the following options:

Option Function/Description
Start Indicates a start date for the analysis. By default, the start date is disabled. By unchecking

Relative, users can enter or select a start date, or select the Calendar button to enter a start
date.

End Indicates an end date for the analysis. By default, the end date is disabled. By unchecking Today,
users can enter or select an end date, or select the Calendar button to enter an end date.

Change Period Indicates the change period. By default, MIMIC selects Years. Options include Days, Weeks,
Months, Years, and All Data. Users can select All Data to pull from all the data for the series.

The Worksheet Options pane in the Data Builder includes the following options:

Option Function/Description
Chart Title Indicates a title for the chart. MIMIC centers the chart title above the chart.

Skip all NaN When checked, skips all NaN values for the analysis.

Skip Weekends When checked, skips all weekend dates for the analysis.

Table Summary Stats When checked, includes the summary statistics at the bottom of the table results. Summary
statistics include the sum, average, etc.

Seasonal Analysis When checked, enables Seasonal Analysis, allowing users to select a seasonal analysis based
on seasons or averages.

Seasonal Analysis 
The Seasonal Analysis option is available n the Worksheet Options pane and allows users to configure
worksheet data based on the season or seasonal averages. This option is available by checking Seasonal
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Analysis, and then selecting the Seasonal Analysis Configuration  button. The Seasonal Analysis
Configuration window opens and includes two tabs: the Seasons tab and the Averages tab.

Seasons Tab
The Seasons tab in the Seasonal Analysis Configuration window includes the following options:

Option Function /Description
Start First Season Indicates a start date for the season. Users can enter or select a start date, or select the

Calendar button to enter a start date.

End Last Season Indicates an end date for the season. Users can enter or select an end date, or select the
Calendar button to enter an end date.

Lock included seasons with
date range.

When checked, adds changes to the start and end season entries. By default, Lock periods
with date range is checked. When unchecked, users must select the Add button to choose the
desired dates.

Seasons included in analysis When checked, displays the results for the period in the resulting chart or table.

Execution Units Sets the execution units for the seasonal analysis.

Averages Tab
The Averages tab in the Seasonal Analysis Configuration window includes the following options:

Option Function/Description
Averages of all Seasons When checked, displays the average in a chart or table for all seasons entered under the

Seasons tab.

Custom Averages When checked, enables the lower section of the tab. This option allows users to customize the
years used for the average. Users can select the Add button to add years to the average, select
the Edit button to modify the years chosen, or select the Delete button to delete the custom
average.

Execution Units Sets the execution units for the average.

Missing Data NaNs 
The Missing Data NaNs option is available in the Worksheet Options pane and allows users to manage
missing data values.

To select a Missing Data NaNs option, users must first uncheck Seasonal Analysis, if checked, and must
also uncheck Skip All NaN. MIMIC then enables Missing Data Nans.
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MIMIC includes the following Missing Data NaNs settings:

Option Function/Description
Fill NaN Inserts NaN values where there is no data.

Fill Forward Takes the last valid value in the series and copies it forward, eliminating the NaNs until the next
valid value occurs.

Fill End Fills the missing data using the last known value for a symbol for a specified date range. For
instance, on a Monday morning, you might want the last known value for the Close of CL. Using
Fill End with a few other settings, the value returned will be Friday’s closing unless Friday is a
holiday and then MIMIC returns the last known value.

The following graphic displays the last known value for the Close of NG for February 25, 2005.

To create the results above, users can select the End Date 02/25/2005, uncheck Skip All NaN
and select Fill End for the Missing Data NaNs. Users must set the Change Period to 0 Days. If
today is 02/25/2005 (before the market closes) then the value returned in the tabled results is the
value from the closing the day before on 02/24/2005.

To find the last known value for a date range (for instance, the last known value for the last 3
days) users can enter 2 Days for the Change Period.

Fill Backward Takes the first valid value after a run of NaNs and fills the value back in time to the previous valid
value.

Fill Blank Fills missing data values with a blank.

Fill Interpolate Linear Creates synthetic values for the span of NaN values based on the last known value and the next
known value by creating linear interpolated values between them.

Formula: 

where:

x1 = last known value
x2 = next known value
w1= the number of days from x1 to the missing date
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Option Function/Description
w2 = the number of days from x2 to the missing date

Fill Interpolate Geometric Creates synthetic values for the span of NaN values based on the last known value and the next
known value by creating geometric interpolated values between them.

Formula: 

Fill Interpolate Logarithmic Creates synthetic values for the span of NaN values based on the last known value and the next
known value by creating logarithmic interpolated values between them.

Formula: 

Fill Nearest Fills Saturday with Friday and fills Sunday with Monday.

Execution Units
The Execution Units option is available in the Worksheet Options pane and determines the time-
frequency over which queries range through the database looking for answers. The default frequency is Daily,
but may be changed to any frequency from 1 minute to any number of years.

Axis Config
Axis Config is a button in the Worksheet Options pane and allows users to edit the position of a series in a
chart. By selecting the Axis Config  button, users open the Axis Config tab and can change the
axis of a series by checking the appropriate axis selection. Users can return to the Configuration window by
selecting the Back to Configuration  button, or by selecting the Configuration  button
from the toolbar.
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CHAPTER 9

User Preferences

User preferences are set in the User Preferences window. To open the User Preferences window, select
Options>User Preferences from the menu bar.

 The different tabs at the top of the User Preferences window include General, Check/Clean Table Data,
Printing, Desktop/Excel, Charting and Screening.

For some of the user preference changes to take effect, you must either restart the program or
start a new worksheet.
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General Tab
The following options are available when the General tab is selected on the User Preferences window:

Option Function
Date format Use the pull-down to change the order of the date display.

Include Average of yearly data Includes the average of yearly data in a chart.

Lock Units of Measure by
default

Converts the unit of measure for a symbol to the same unit of measure as a previously entered
symbol when conversion factors are available.

Always force 7 day trading
pattern

Always use a seven-day trading pattern versus a five-day pattern.

Use Stream Semantics This is a future enhancement to accommodate display of millisecond data.

Use 800x600 pixel mode Sets the screen display to 800x600 pixels. If you have your monitor resolution set to 800x600 and
you select the box for 800x600, then the whole MIMIC chart will fit on your monitor.

Save Graphics as Saves graphics as BMP, PNG or as a JPG file.

Round Mode The round mode determines how MIMIC will treat rounding when the user selects a precision for
the series that is less than the number of decimals in the value returned (e.g. precision selected is
2 decimals, the number is 3 or more decimals).

In such cases, the user can now specify the rounding technique used by choosing between 3
alternatives:

● Half Even (the default) - Rounds any trailing 5 up or down to the nearest even number (e.g. if
the decimal precision is two decimals and the number to be rounded is 2.345, the calculation
rounds down to the nearest even value at 2.34, whereas if the number to be rounded is 2.355,
the calculation rounds up to the nearest even value at 2.36.)

● Half Up - Always rounds the trailing 5 up.

● Half Down - Always rounds the trailing 5 down.
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Table Tab
The Table tab on the User Preferences window includes the following options:

Option Function
Warn if table data includes zero
or NaN values

Displays a warning if there is null or no data values for a date.

Remove data in table if row has
a zero or NaN values

Removes null or no data, if it exists.

Show summary stats Selected by default. Includes summary statistics, such as the sum, averages, percentages, and
the standard deviation.

Skip weekends Excludes weekend data (data for a Saturday or a Sunday).

Note: This feature can only be selected when using the following Execution Units in the
Worksheet Options pane: Days, Hours, Minutes, Seconds and Milliseconds.

Sort by: Date Ascending Sorts the table data by the oldest date first.

Sort by: Date Descending Sorts the table data by the most recent date first.

Printing Tab 
The Printing tab allows users to select the page orientation for printing tables.

Option Function
Orientation This option allows you to select the page orientation for printing tables. Options include

Landscape and Portrait (default). These options are for table printing only.

Desktop/Excel Tab 
The following options are available when the Desktop/Excel tab is selected on the User Preferences
window:

Option Function
Copy table results to clipboard Copies the table results to the clipboard, so you can use them in another application.

Send New Worksheet/paste
command to Excel

Creates a new worksheet in Excel and pastes the results of a MIMIC table.

Send Paste command to Excel Pastes the results of a table into an open Excel worksheet.
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Charting Tab
The following options are available when the Charting tab is selected on the User Preferences window:

Option Function
Use description as chart label The description entered for a symbol is used as the chart label.

Show Grids Places a grid line behind the chart.

Show Chart Controls Turns on the chart controls at the bottom of a chart. Sets trendlines and zoom. Use the Mouse
Pick feature to display the symbol data on a specific date, as well as delta and percent change
data.

Show Legend Display the legend stacked vertically or spread out horizontally. Use the Legend Anchor settings
to position the legend in the North, South, East or West quadrant of the chart.

Show Chart Symbol The lines in a chart are given a unique symbol. This setting helps when printing charts in black
and white so the user can distinguish between symbols.

Screening Tab 
The Screening tab allows users to set a screen server URL.

Option Function
Screen Server URL Complete URL address of the Screen Server.
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CHAPTER 10

Searching in MIMIC

MIMIC offers a flexible means of database searching. Using the functionality of the Tree View and Search
tabs, you can tailor the level of refinement in your searches according to symbol name or description in
several different ways.

Searching Methods
The following shows how to begin a search:

1. Select the Search Database button on the Configuration window.

The Data Builder changes to include two tabs: Tree View and Search.

2. On the Tree View tab, drill down through the data listings by clicking the plus or minus signs to expand/
collapse the folder and symbol icons.

3. Double-click on a column to add the desired symbol to the Worksheet. Multiple symbol selections can be
added to the worksheet by using either the Ctrl or Shift key in combination with a mouse click.

You do not have to go down to the column level to add symbols. To use the default columns
for the symbols, right-click and choose Select.

Alternatively, you can search the MIMIC database using the Search tab functionality:

1. On the Search tab, enter a symbol name in the Search field and select the Start search button.

By default, entries are not case-sensitive.
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2. Select the Search Options button to see a list of search options:

You can either search for a symbol name or search in the description field by selecting Symbols or
Description from the pull-down list (Symbols is selected by default).

Searching by Symbol
If you already know the symbol name and simply want to locate the directory path, you can perform a refined
search to search for a specific symbol. A maximum of 100 results are returned.

1. On the Search tab, enter the symbol name in the Search field. To search by symbol, select the Search
Options button and ensure that the Symbols option is selected.

2. Select the Start search button to start the search.

Adding Result(s) to the Worksheet
The search results are listed by symbol, path and description. There are several methods for adding the results
to a worksheet.

1. To add a single symbol result to a worksheet, double-click on the entry (default column will be used).

2. To add multiple selections, use the Shift and Ctrl keys. Right-click and choose Select Items.

The default columns will be used.
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3. To add a symbol with a column other than the default, double-click the entry from the columns list.

Instead of double-clicking on a column name, another selection option is to right click and
select choose selected column.

Mapping a Result in the Tree View
To have a particular result mapped in the Tree View, select the desired result, right-click and select Locate in
Tree. The Tree View displays with the path to the symbol.

Searching by Description
If you have a description, you can search by entering the keyword word or phrase in the search field and
choosing Descriptions from the pull-down menu. Select the Start search button (or press Enter on your
keyboard) to start the search.

Narrowing a Search
Searching on a broad description will yield a maximum of 100 results. To narrow the results choose from
one of the pre-defined narrowed lists (All Equity Tickers, AMEX Tickers, NASDAQ Tickers, NYSE Tickers,
Energy Symbols) or use the Custom Narrow feature to browse the hierarchy, then select the category you
want to refine.

The following example searches for an instance of “Henry Hub” as a spot price off the Platts publication,
and uses the Custom Narrow feature to browse the hierarchy and only search in the Energy>NaturalGas
folder.

1. Enter henry hub in the Search field.

2. Select the Search Options button and choose Descriptions and Custom Narrow from the pop-up
menu.

3. In the Custom Narrow list, open the Energy folder, and then open the NaturalGas folder. Make sure
the NaturalGas folder is highlighted.

4. Select the Start search button (or press Enter on your keyboard) to start the search.



40
 

MIMIC USER GUIDE
Chapter 10: Searching in MIMIC

5. Scroll down the list of results and select the appropriate symbol. Double-click on a column to add the
symbol information to the worksheet. To add multiple symbols and columns use the Shift or Ctrl keys
to select the columns, then double-click and press Enter, or right-click and select Choose Selected
Columns to add the selections to the worksheet.

Search Options
To open the Search Options, select the Search Options button from the search field. The last entry in the
pop-up list is Search Options.

The following search options and rules may be applied when searching by description or by symbol:

Option Function
Case Sensitive The search will only match the supplied case.

Include Symbols The symbol is included in the criteria.

Include Categories The category description is included in the criteria.

Show Path in Table The path to the symbol is included in the results.

The following search criteria may be used:

Criteria Function
Asterisk “*” The asterisk is a wildcard. Note that typing “Henry Hub*” without a wildcard at the beginning will

return strings that begin with “Henry Hub” versus strings that include “Henry Hub”.

Period “.” Do not use as a wildcard; it will be interpreted as a period.

Question mark “?” The question mark is a wild card to change a single character.
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Charts

A chart is a visual representation of data over a specified period of time. You can create a chart of the
Worksheet data you entered in the Configuration window. To chart this Worksheet data, select View >
Chart from the menu bar, or select the Chart  button from the toolbar. MIMIC displays a chart in the
Chart window.

To return to the Configuration window, select the Configuration  button from the toolbar.

In a chart, there are certain options, features and settings you can make. These settings can apply to the
following:

● The current or active chart displayed in MIMIC.
● All future charts you create in MIMIC.

To select options and settings for the current chart, select View > Chart Options from the MIMIC menu
bar. To select options and settings for all future charts, select Options>User Preferences from the menu
bar, and then select the Charting tab.

For more information on the Charting tab, see “Charting Tab” in this guide.

To print a chart, select File>Print Chart from the MIMIC menu bar, or select the Print  button from the
toolbar.

Chart Options
For a current or active chart, you can set or display a grid, chart symbols, chart controls, the legend, the
legend anchor and the legend orientation. To access the chart options, select View>Chart Options from the
MIMIC menu bar. If a chart option is selected, MIMIC displays a check mark or a radio button to the left of
the option.
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MIMIC includes the following chart options:

Option Function
Grid Displays a gridline on the chart.

Symbols Displays a separate and distinct icon for each symbol when charting more than one symbol. This
option does not function when charting only one symbol.

Controls Displays the Chart Controls at the bottom of the Chart window. Use these controls to set
trendlines, select the Mouse Pick feature and enable zoom.

● Trendlines - Create trendlines by toggling the Trendline Off button to Trendline On. On the
chart, use the mouse to click and drag a line that connects a series of peaks or troughs. You
can hide/show trendlines by toggling the Hide Trendlines/Show Trendlines button. You can
reset all trendlines by selecting Reset>Trendlines, or you can delete the last trendline created
by selecting Erase Trendline.

● Mouse Pick - Compare two points in a chart by toggling the Mouse Pick Off button to Mouse
Pick On. This feature opens a table at the bottom of the chart and provides data such as
dates, values, delta and percent change.

● Zoom  - Zoom in on a certain period for the data by toggling the Zoom Off button to Zoom
On. On the chart, use the mouse to click and drag a rectangle around the desired time period.
Select Reset>Zoom to return to the original view.

Legend Displays the symbols in a legend on the chart.

Legend Anchor Displays the legend North, East, South or West of the chart. North = above the chart, East = to
the right of the chart, South = below the chart, and West = to the left of the chart. MIMIC displays
a radio button before the selected legend anchor in View > Chart Options.

Legend Orientation Displays the legend vertically (one symbol above another) or horizontally (side-by-side). MIMIC
displays a radio button before the selected legend orientation in View > Chart Options.

Color Configuration
By default, MIMIC displays a chart in color. MIMIC assigns default color palettes for the chart viewed as
part of the application and for printing in color. MIMIC also assigns default grayscale palettes for printing
in black and white. MIMIC sets the palettes for the Background, Foreground, Trendline, Average, and for
each symbol. Symbols are represented as Data1, Data2, etc. For example, the first symbol you have in the
Worksheet (in row 'A') is represented as Data1, the second symbol you have (in row 'B') is represented as
Data2, and so on.

To change a palette, select Options>Color Configuration from the MIMIC menu bar. The Color
Configuration window displays. Click the color you want to change, the Pick a Color window appears
where you can select a new palette.
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Tables
A table is a statistical representation of data for a future or commodity over a specified period of time. You
can create a table of the Worksheet data you entered in the Configuration window. To table this Worksheet
data, select View > Table from the MIMIC menu bar, or select the Table  button from the toolbar.
MIMIC displays the table in the Table window.

To return to the Configuration window, select the Configuration  button from the toolbar.

A table contains a Dates column and then a column of data for each symbol. For example, row 'A' from the
Worksheet is the first column of data, row 'B' the second column of data, and so on. A table contains data
for the dates indicated in the Date Options pane. At the bottom of a table, MIMIC displays table summary
statistics.

In a table, there are certain options, features and settings you can make. These settings can apply to the
following:

● The current or active table displayed in MIMIC.
● All future tables you create in MIMIC.

The options and settings for the current table are set in the Worksheet Options pane. To select options and
settings for all future tables, select Options>User Preferences from the menu bar, and then select the Table
tab.

For more information on the Table tab, see “Table Tab” in this guide.

To print a table, select File>Print Table from the MIMIC menu bar, or select the Print  button from the
toolbar.

Table Options in the Worksheet Options Pane
For a current or active table, you can set the table data to skip all NaN values, skip weekend values, include
table summary statistics, and set the display to ascending order. By default, all these options are selected.
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MIMIC includes the following table options in the Worksheet Options pane:

Option Function
Skip All NaN Removes null data values for a date, it they exist.

Missing Data NaNs Fills table with specified data for all NaN values.

Skip Weekends Excludes weekend data (data for a Saturday or a Sunday).

Note: This feature can only be selected when using the following Execution Units in the
Worksheet Options pane: Days, Hours, Minutes, Seconds and Milliseconds.

Table Summary Stats Includes summary statistics, such as the sum, averages, percentages, and the standard
deviation.

Table Date Sort Ascending Sorts the table data by the oldest date first.

You can also include seasonal analysis information in your table. For more information on
Seasonal Analysis, see “Seasonal Analysis ” in this guide.

Sorting Table Data
By default, MIMIC sorts table data in ascending order, with the oldest date first and the most recent date last.
You can easily sort any column in ascending or descending order by clicking on any column heading. MIMIC
displays an up-arrow symbol in the column heading you clicked to indicate descending order, and displays a
down-arrow symbol in the column heading you clicked to indicate ascending order:

Once you exit the Table window, MIMIC clears your sort order.
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Table Summary Statistics
MIMIC includes the following table summary statistics:

Table Statistic Description
Sum Indicates the sum total of the values returned in the answers.

Average Indicates the average of the data for a column.

Average (+) Indicates the average of all the values in the answers.

Average (-) Indicates the average of the negative answers to the query.

Percent (+) Percent positive. Indicates the number, as a percentage of the total number of occurrences, of
positive answers to the query

Percent (-) Percent negative. Indicates the number, as a percentage of the total number of occurrences, of
negative answers to the query.

Maximum Indicates the maximum of all the query answers.

Minimum Indicates the minimum of all the query answers.

Std Deviation Measures the mean deviation from the average of the answers. This can be a particularly
valuable tool to interpret the answers to the query. For example, if the average return on a query
is 3%, but the Standard Deviation on that is 10%, then it indicates a poor signal. It is best to have
a standard deviation that is lower than the absolute value of the average value returned in the
query.

Zstat Indicates the Z-score of the results. This measures the goodness of the average.

Variance This is related to the standard deviation calculation, which is actually the square root of the
variance.

Last Repeats the last value of the column data.

MIMIC does not sort table summary statistics.
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Stored Formulas

The functionality of the MIMIC Stored Formula tab allows you to create custom formulas that can be saved
as names in the database for reuse in MIMIC queries and shared among other users. Since a formula is stored
as a relation, the formula can be used in MIMIC just like any other relation, thus providing time management
savings. A custom formula can save time anywhere there is a need to reuse a query expression.

Activation of this feature requires additional fees.

MIM Schema Browser
Use the MIM Schema Browser pane to browse and select a symbol (Import item as Variable) or edit your
formula by browsing for a formula (Import item as Formula).

Use the Refresh button located in the bottom right-hand corner of the MIM Schema Browser to close all
the folders in the browser window.

Import Item as Variable
Select Import item as Variable to use the browser to locate and add a symbol and column for creating a
formula. Open the folders and locate the desired symbol name. Open the symbol and highlight the desired
column, then right-click and choose Select to add the symbol and column to the Worksheet.

Import Item as Formula
Select Import item as Formula to browse for, locate and select a formula for editing.
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Symbol Information
When a formula is selected from the MIM Schema Browser pane, the fields in the Symbol Information
pane populates with the relation name, column units of measure and time units. When a new formula is
created, fields may be entered manually.

MIMIC includes the following symbol information in the MIM Schema Browser pane:

Option Function
Symbol Enter a symbol name or use the MIM Schema Browser: Import as Variable to select a symbol

and column.

Column Select a column from the pull-down or use the MIM Schema Browser: Import as Variable to
select a symbol and column.

Units of Measure Use this field to modify the units of measure for the symbol.

Time Units Select a time unit: Minutely, Hourly, Daily, Weekly, Avg Weekly, Monthly, Avg Monthly.

Formula Specifications
Use this area to define the formula expression, providing a name and description for the formula and using
the different options available.

MIMIC includes the following formula specifications:

Option Function
Relation Assigns a name to the relation. This name displays when Import as Formula is selected from the

MIM Schema Browser.

The expression name will become the MIM symbol by which the formula is known, once it is
created. The name must conform to some basic MIM symbol naming rules. Since the formula
expression must be a unique name, it is important to be careful when assigning names.

Note: Always use your name or a similar recognized prefix at the front of your formula expression
name. This will ensure the unique identity of the formula expression name and will reduce the
risk of naming conflicts. For example, “MYNAME.FORMULA_1” where “MYNAME” is followed
by a period. It is not possible to use the same name within your own Formula folder (will simply
overwrite your formula) or any other user’s Formula folder.

The name must conform to the following rules:

● Must be a unique name.
● Use uppercase characters.

Note: You are not permitted to type lowercase characters in the Relation name field.
● No spaces in the name.
● Only letters and numbers are permitted—characters such as “-“ or “@” and others are not

allowed.
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Option Function
● The underscore is permitted.
● Periods are allowed. If the name assigned does not follow these rules, then an error message

will display when you try to save the expression.

Description Enter a description for the formula. The description for the formula displays after the symbol name
in the MIM Schema Browser.

Relation Column The Relation Column field is always Value, so there is no need to edit this field.

Trade Pattern For trading pattern, select whether the symbol trades 5 days a week or every day of the week.

Expression This is the area where the formula expression is entered.
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CHAPTER 14

MIMICExcel

MIMICExcel is an application that users can run from within Microsoft Excel. Users first open Excel and
then from within Excel, MIMICExcel can be opened.

The main purpose for using MIMICExcel is to table the query results in an Excel spreadsheet, use Excel
functionality with the query results, and to be able to automatically refresh or update the query results.
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MIMIC vs. MIMICExcel
MIMIC is a stand-alone product and application that allows users to create queries, and to display the query
results in a chart or table. MIMICExcel is a program that is used from within Excel. On the interface,
differences in MIMICExcel include the title bar and the addition of the MIMICExcel toolbar above the menu
bar.

The following shows the differences between the two applications:

MIMIC MIMICExcel
Is a stand-alone application. Is a program that runs within Microsoft Excel.

Can create a single query. Can create multiple queries.

Saves queries with a .llc file extension. Saves or embeds queries in MIMICExcel, and saves each query
separately with a .llc file extension for use in MIMIC.

Tables query results in the Table window. Tables query results in an Excel spreadsheet.

Cannot refresh or update query results from the server. Can refresh or update query results from the server.

Toolbars for MIMICExcel
There are two toolbars associated with using MIMICExcel: the MIMICExcel Add-in toolbar and the
MIMICExcel toolbar.

MIMICExcel Add-in Toolbar
The MIMIC Add-in toolbar appears in Microsoft Excel and is combined with the MIMIC menu:

The MIMICExcel Add-in toolbar contains two buttons:

Button Description Function
Enter MIMIC Opens MIMICExcel.

Refresh MIMIC
Queries

Connects with the server and updates the data for all queries.
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The MIMIC menu includes three options.

Menu Option Function
Enter MIMIC Opens MIMICExcel.

Refresh MIMIC Queries Connects with the server and updates the data for all queries.

Advanced Refresh Mode Once selected, allows users to refresh MIMIC queries using specific start and end dates for either
the active worksheet or for all worksheets.

MIMICExcel Toolbar
The MIMICExcel toolbar appears at the top of the MIMICExcel interface and contains three buttons.

Button Description Function
Back to Excel Closes MIMICExcel.

Query Manager Opens the Query Manager, allowing users to edit, copy, rename or delete a query.

Embed Query Saves and embeds a query within MIMICExcel.

Queries in MIMICExcel
Queries in MIMICExcel are created the same way as they are created in MIMIC. Users enter criteria for a
query in the Configuration window. Each query can contain more than one item or row in the Worksheet.
Unlike MIMIC, MIMICExcel allows users to create more than one query, and these queries can be embedded
or stored in MIMICExcel. This type of query is called an embedded query. Users can enter a name and
description for each embedded query, and set the starting cell location where the query results will be posted
in Excel. When posted, each query occupies a column for the date, and another for the results.

Query results appear in a chart the same way in both MIMIC and MIMICExcel; however, for tables, query
results in MIMICExcel are posted to an Excel spreadsheet instead of to the Table window.

In MIMICExcel, users can save queries in different ways:

● Users can save or embed a query within MIMICExcel. When saving a query in this manner, users must
also save the Excel spreadsheet. The spreadsheet will be saved with an Excel .xls file extension. Users can
embed multiple queries. Other users can open the Excel spreadsheet to view the query results, and then
open MIMICExcel to view the details of the query or queries and manage them.

● Users can save or export a query in MIMICExcel. This type of query is saved with a .llc file extenion and
referred to as a MIMIC worksheet file or a LLC worksheet. Other users can open this file or query in
MIMIC or in MIMICExcel.
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Users cannot export multiple embedded queries as one LLC worksheet. Each embedded
query in MIMICExcel must be exported as a separate and independent LLC worksheet. For
example, if MIMICExcel contains three embedded queries, the user must select each query
separately and save each query as its own LLC worksheet.

Embedding a Query
In MIMICExcel, users can create and embed more than one query. Embedding a query is another way to
describe saving a query within MIMICExcel.

Users must embed a query before they can table the query results to an Excel spreadsheet. To save or embed
a query, users can select the Embed Query  button from the MIMICExcel toolbar, or select the Table

 button and be prompted by MIMICExcel. MIMICExcel prompts users to embed the query, if the query
has not been saved and they try to table the results. Embedded queries are saved using the Embed Query
window:

Users can enter a name and a description for the query, and specify the starting location or cell in Excel where
the query results will post. To specify a location, users can select the Browse  button.

It is recommended that users select a different starting cell location for each embedded query,
and ensure that subsequent embedded queries are separated by at least two columns to allow for
the date and results of each query.
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Query Manager
More than one query can be saved or embedded in MIMICExcel, and embedded queries are stored by
MIMICExcel in the Query Manager. To open the Query Manager, users can select the Query Manager 
button from the MIMICExcel toolbar. The Query Manager allows users to manage embedded queries:

Users can only access embedded queries by using the Query Manager. Users cannot open a query
from the menu bar or from any toolbar.

In the Query Manager, users can select an embedded query and view its description and starting location.
Users can also edit, copy, rename or delete a query.

To edit the description or location of a query, users must first open the query and then re-save
the query by selecting the Embed Query  button. Then in the Embed Query window, users
can enter a new description or location.

Refreshing MIMICExcel Queries
In MIMICExcel, query results are tabled to an Excel spreadsheet. Users can refresh or update the query
results. When refreshing, MIMICExcel connects to the server and receives the latest data, and then replaces
the old data in the Excel spreadsheet with the new data. MIMICExcel refreshes the results for all embedded
queries.
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To refresh the queries, users can select MIMIC>Refresh MIMIC Queries from the Excel menu bar, or
select the Refresh MIMIC Queries  button from the MIMICExcel Add-in toolbar.

Advanced Refresh Options
MIMICExcel has advanced refresh options which allow users to indicate a specific start and end date for a
query, and if the the advanced refresh options apply to the active worksheet, or to all worksheets.

To use the Advanced Refresh Options in MIMICExcel, users must first select MIMIC>Advanced Refresh
Mode from the Excel menu bar. Once selected, this option is indicated with a check mark in the MIMIC
menu. Then, users can select MIMIC>Refresh MIMIC Queries. The Advanced Refresh Options
window displays, where users can modify the start and end dates for the queries, and specify that the
advanced options apply to the active worksheet or to all worksheets.

LLC Worksheets
In MIMIC, users can save a query, so that other MIMIC users can open it. Saved queries are called MIMIC
worksheet files, or LLC worksheets and have a .llc file extension.

In MIMICExcel, users can save or export an embedded query as a LLC worksheet. Users can have more than
one embedded query, but each embedded query must be saved as a separate and distinct LLC worksheet.

To export an embedded query from MIMICExcel, users can select File>Save or File>Save As from the
menu bar, or select the Save  button from the toolbar.

To open a LLC worksheet, users can select File>Load from the menu bar, or select the Open  button
from the toolbar.
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Formula Table

Overview
The following tables are provided to outline the structure or format of commonly used mathematical 
Formulas  that may be typed directly into the  Formula  text field of the  Data Builder . In addition, several
examples of these  Formulas  have been provided in the body of each table.

Formulas for Built-ins

% Move or Move
Percent Move is the difference, expressed as a percentage, between a specified starting value and an ending
specified value. Move calculates the difference between a specified starting value and an ending specified
value.

If either X or X n is a NaN, the immediately preceding value will be considered instead, i.e., X  1  or X  n+1 .
If these values are also NaN, the percent move will be NaN as well. For example, when computing a 2 day
percent move, if X is a NaN, but X  2  is not, then XMIM will return X  1   – X  2  instead of X – X  2 . But, if
X  1  is also NaN, then XMIM will return NaN.

Note that percentMove is negative precisely when the move is negative; i.e., the percent move
from -10 to -12 is -20, not 20.

Constant (Number) Time-Period (day/mth/yr) “% move” or "move" of Series
4 day % move of HO
1 month move of CL
2 Quarter % move of (HO – CL)
1 Month move of (1 week average of HO)
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Absolute Value
This study returns the absolute value for a specified Attribute. Where the value is a holiday or missing data
series (expressed as NaN) the return will be NaN.

If X is NaN, absoluteValue returns NaN as well.

“absolute_value” of Series
absolute_value of HO

Adjust Contract
MIMIC will adjust all studies using futures contract so that the artificial price jump associated with the
expiration of a contract will not be factored into the study. For example, if a study using the front continuous
contract captured a time period which included a roll or expiration date, by default, that price difference
between the old or expiring contract and the new contract would be subtracted or backed out of the equation
as of the expiration date. The adjust_contract function is used so that the jump or price difference associated
with expiration (cost of carry) is not adjusted out of the study. There are four fields that are required to
be specified within this study- the Attribute or series, the deferred number of the contract chosen (i.e., 1
represents the contract nearest to expiration or the front contract, 2 represents the second nearest contract
to expiration, etc.), the number of days until expiration that the contract should be followed (i.e., 0 specifies
that the contract will be active until expiration, 1 specifies that the contract will be active or followed up until
1 day before expiration, etc.) and contract month which is the parameter which specifies the contract month
of interest (i.e., setting the field to 0 will disable this field thereby allowing the contract to roll to the regularly
traded serial months, setting the field to 1 will specify only January contracts, etc.).

where  is computed by offsetting each relation of type futures in X with an appropriate amount so that the
expiration-day boundaries do not introduce an artificial jump.

adjust_contract “Series” Contract Number Days to Expiration Month of Interest
adjust_contract (HO, 1, 0, 0)
adjust_contract (CL, 2, 5, 1)
adjust_contract (NG, 3, 3, 0)
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In the examples above the first example would create a series that when used in a  Formula 
within another row of the worksheet would unadjust the continuous price series for the nearest
to expire (or front) month. This series is set up to ‘roll’ on the expiration day. The next example,
when used in a  Formula  within another row of the worksheet, would unadjust the continuous
price series for the second nearest to expire (or back) January month (connects only January
contracts). This series is set up to ‘roll’ five days before the expiration day of the contract. The
last example, when used in a  Formula  within another row of the worksheet, would unadjust the
continuous price series for the third nearest to expire (or back) contract. This series is set up to
‘roll’ three days before the expiration day of the contract.

The following shows further examples to demonstrate the use of adjust contract.

Example 1: Consider the trading day of 10/8/2002 for the following scenarios. The “prompt” crude oil
contract would be Nov 2002, CL_2002X .

Data Table:

Date LIM SYMBOL adjust_contract version
10/8/2002 CL_2002Z - Close adjust 1st December contract out

adjust_contract (CL, 1, 0, 12)
29.51 29.51

CL_2003J - Close adjust 6th contract month out
adjust_contract (CL, 6, 0, 0)

27.6 27.6

CL_2004H - Close adjust 2nd March contract out
adjust_contract (CL, 2, 0, 3)

23.86 23.86

CL_2005F - Close adjust 3rd January contract out
adjust_contract (CL, 3, 2, 1)

23.03 23.03

Let’s look closer at each of these to see how the adjust_contract function chooses the correct contract.

December 2002 contract: This is the nearest December contract right now. The explicit LIM symbol is
CL_2002Z. To ask for the closest contract month using adjust_contract you fill in adjust_contract (CL, 1, 0,
12), where:

● CL = base commodity symbol of choice.

● 1 = N nearest. 3 would imply the 3rd nearest, 6 the 6th nearest.

● 0 = This is “Number of days before Expiration”. Setting this number to “0” indicates the series will locate
the next nearest contract when the contract expires. Setting this number to “4” would mean that the
contract should roll to the next one 4 days before expiration of the current contract.
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● 12 = This is the contract month, 12 equals December, 5 equals May, 7 equals July. Note: Setting this
number to “0” makes the parameter inactive, meaning the other parameters will determine the behavior.

April 2003 contract: This is the 6th nearest contract out. The explicit LIM symbol is CL_2003J. To ask for the
literal N contract out using adjust_contract, you fill in adjust_contract (CL, 6, 0, 0), where:

● CL= base commodity symbol of choice.

● 6 = N nearest. 6 points to the 6th closest or nearest to expiration active contract.

● 0 = This is “Number of days before Expiration”. Setting this to “0” indicates the series will locate the next
nearest contract when the contract expires. Setting this to “4” would mean that the contract should roll to
the next one 4 days before expiration of the current contract.

● 0 = Normally, this is where you put in the contract month. However, since we want the exact 6th closest
contract, this is set to “0”.

March 2004 contract: This is the 2nd nearest March contract. The 1st nearest is the March 2003 contract. The
3rd nearest would be March 2005. To ask for the 2nd nearest March using adjust_contract, you would fill in
adjust_contract (CL, 2, 0, 3) where:

● CL = base commodity symbol of choice.

● 2 = 2nd nearest

● 0 = This is “Number of days before Expiration”. Setting this to “0” indicates the series will locate the next
nearest contract when the contract expires.

● 3 = March contract.

January 2005 contract: This is the 3rd nearest January contract. The closest or first nearest would be January
2003. To ask for the 3rd nearest using adjust_contract, you will fill in adjust_contract (CL, 3, 2, 1), where:

● CL = base commodity symbol of choice

● 3 = 3rd nearest

● 2 = This is “Number of days before Expiration”. Setting this to “2” indicates the series will roll 2 days
before the contract expires and choose the next 3rd nearest contract.

● 1 = January contract.

Example 2: More Real-World Examples

How do you ask for?

1. Spread between the 2nd December and the 1st December contract. Often times this is referred to as a
Dec – Red Dec spread.
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adjust_contract (CL, 1, 0, 12) – adjust_contract (CL, 2, 0, 12)

2. The spread between the 1st and 2nd nearby contracts.

adjust_contract (CL, 1, 0, 0) – adjust_contract (CL, 2, 0, 0)

3. The 3rd nearest November contract.

adjust_contract (CL, 3, 0, 11)

4. The 15th closest contract out.

adjust_contract (CL, 15, 0, 0)

Average
Calculates a simple moving average of values in the specified time period. When calculating an N day average,
XMIM will display a moving N day average for any executable date; however, where there is a holiday or
missing data point (expressed as NaN) a moving average of less than N days will be displayed. For example,
if a 5 day average was calculated and our executable dates include December 25, a holiday, the study would
calculate a 4 day average for this date because no data point exists for December 25. Likewise, on December
26 a 4 day average will be displayed because of the missing data associated with the holiday. On December 25,
a 5 value average will display (NaN) because no data exists to perform the calculation. However on December
26, or the next date where data exists, the study include the data on December 26 and will search back for the
other 4 values to perform the calculation (skipping over December 25). To ensure that N actual ‘values’ are
used in the calculation the term value should be substituted instead of day in the formula.

Constant (Number) Time Period (day/mth/yr) “average” of Series
5 value Average of HO
3 month Average of CL
2 quarter Average of NG
1 year Average of HU
4 week Average of PN

The term “value” may be used to anchor 5 absolute values to be used in the calculation for the
above example. If one the five values were unavailable for the 5-day average, MIMIC would
substitute a 4-day average. To ensure that 5 actual ‘values’ are used in the calculation the term
value should be substituted instead of day in the formula. Also, on a day without data the use of
‘value’ in the formula would return a “NaN” (not a number, indicating that no values existed on
that day for the calculation).
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Bollinger High/Bollinger Low
Bollinger_high and Bollinger_low studies return values that are derived from a moving average plus (high)
or minus some relative percent of the moving average. The relative value, subtracted or added to the moving
average, is the standard deviation for the time window. These price bands can be defined so that they
encompass most of the price activity with the ceiling (bollinger_high) coinciding with the relative highs and
the floor (bollinger_low) coinciding with relative lows. These significant high and low thresholds can be used
to measure overbought or oversold levels in the market. There are three fields that are required to be specified
within this study- the Attribute or series, the relevant time period for the study and the width of the band (1
denotes 1 standard deviation, 2 denotes 2 standard deviations and 3 denotes 3 standard deviations).

“bollinger_high/
bollinger_low”

Series Constant (Number) Time Period (day/mth/yr) Constant (Number)

bollinger_high/bollinger_low (HO, 1 day, Standard Deviation)

Compound_return
Compund_return is the accumulated return of a specified relation column, between a specified start and end
date. Since the formula relies on multiplication, all NaN values should be skipped at all times. If the relation
column value is zero, then the value is 1. If the relation column is all NaN then the return value is NaN. For
this study, it is practical to use % move as the attribute.

where C = compound_return and R = relation column

“compound
_return”

Constant
(Number)

Time Period
(day/mth/yr)

Attribute of Series Time Period
(day/mth/yr)

Time Period
(day/mth/yr)

compound _return 1 day % move of (GII.DELL.NASDAQ) 1 year ago today

Construct Date
This study returns XMIM's mathematical value corresponding to the date month/day/year format.
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where D is an integer corresponding to the date m/d/y (month/day/year format). The number D is guaranteed to
be in the standard date representation of XMIM, as given by the XMIM construct current date.

“construct_date” Constant (Number) Year
construct_date (month, day, 1996)

Coregression
Returns the statistical co-regression of two series where X is the Independent variable and Y is the dependent
variable.

where  and  are the regression coefficients, computed as follows:

As in the case for linear regression, the formulas above are unstable and prone to round-off errors, so we
replace them with the mathematically equivalent ones below:

NaNs are handled exactly as in the case for linearRegression.
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Constant (Number) Time-Period (day/mth/yr) “coregression” of Series
1 day coregression of HO and CL

Coregression_intercept
Returns the statistical co-regression intercept of two series where X is the independent variable and Y is the
dependent variable.

where  is the regression intercept, computed as follows:

As in the case for linear regression, the formulas above are unstable and prone to round-off errors, so we
replace them with the mathematically equivalent ones below:

NaNs are handled exactly as in the case for linearRegression.

Constant (Number) Time-Period (day/mth/yr) “coregression_intercept” of Series
1 day coregression_intercept of HO and CL

Coregression_slope
Returns the statistical co-regression slope of two series where X is the Independent variable and Y is the
dependent variable.
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where  is the regression slope, computed as follows:

As in the case for linear regression, the formulas above are unstable and prone to round-off errors, so we
replace them with the mathematically equivalent ones below:

NaNs are handled exactly as in the case for linearRegression.

Constant (Number) Time-Period (day/mth/yr) “coregression_slope” of Series
1 day coregression_slope of HO and CL

Correlation
This study returns the statistical correlation coefficient between two series. This study will return values
between the range of 1 (perfect correlation) and -1 (perfectly negative correlation).

where  is equal to average (X, n) and similarly for . NaNs are handled exactly as in the case for
covariance.

Constant (Number) Time-Period (day/mth/yr) “correlation” of Series
100 day correlation of HO and CL
1 month correlation of HO and NG
4 week correlation of (HO + CL) and NG
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Count
This study counts the number of occurrences for which a value is returned for a given time period. This
function will not include holidays or other NaN (Not a Number) values in its count.

where defined(X) returns a 0 if X is NaN and 1 otherwise.

Constant (Number) Time-Period (day/mth/yr) “count” of Series
1 day count of HO

Covariance
A statistical covariance measure is the measure of the relationship between two series whose values are
observed over a moving time window.

where  is equal to average (X, n) and similarly for . As in the variance study, if n is less than or equal to 1,
covariance returns NaN.

Constant (Number) Time-Period (day/mth/yr) “covariance” of Series
1 day covariance of HO and CL

Dividend Adjusted Return
Dividend_adjusted_return is the overall percentage return of a dividend paying stock when it is assumed
additional shares (or fractions of shares) are purchased with the dividend gains on Ex-Dividend date at
the current stock’s closing price. On each Ex-Dividend date, the amount of shares increases, but the initial
investment remains the same. The formula assumes a purchase of 1 share at the start date at the then current
closing price (this is the initial investment).
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“dividend_adjusted_return” Attribute of Series Time Period
(day/mth/yr)

Time Period
(day/mth/yr)

dividend_adjusted_return (Close of GII.C.NYSE, 1 year ago today)

Ease of Move
This study is derived from Richard Arms’ Ease of Movement indicator and is a momentum indicator that
incorporates range and volume to signal certain trends evolving within the markets. This indicator was
developed in order to quantify volume and price changes in order to determine the ease, or lack thereof, with
which price is able to move up or down. The formula for this study is the difference of the today's midpoint
minus a previous midpoint multiplied by today's range all divided by today's volume.

where M is equal to midpoint (S) and M1 is the previous value of midpoint (S).

“ease_of_move” of Series
ease_of_move of HO

Exponential Average
There exists a school of thought that says that using a simple moving average system, where all days are
weighted equally, doesn’t properly acknowledge the impact of more recent prices on future price movement.
Hence, it is argued that it would be preferred to ‘weight’ the more recent days more heavily in a ‘moving
average’ equation. This study is calculated as of the sum of the current price multiplied by a ‘weight’ or
smoothing constant and the previous day’s study is multiplied by (1 - weight). The weight of a prior day’s price
will decrease the further back in time, relevant to today’s price, it is. There are two fields that are required to
be specified within this study- the Attribute or series and weight. There are two acceptable ways to calculate
weight: 1 / n (where n represents the number of days) or 2 / n + 1. For example, if we were to use a 14 day
equivalent, we could type in either 1 / 14 or 2 / 14 + 1 into the ‘weight’ field for our study.

where w is restricted to lie in the range  and exponentialAverage  1  (X, w) is the previous value of
exponentialAverage(X, w) (or NaN if none). ExponentialAverage ignores any NaNs in X. That is, if a given value
is NaN, then the exponentialAverage is simply equal to the previous value of the exponentialAverage.

Although exponential average takes into account the entire history of X, it is sometimes useful to compare
it to an “n-day” average. The closer w is to 1, the shorter term the exponential average becomes. From the
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formula, it is clear that for w equal to 1, the exponential average of X is precisely X. Conversely, the closer w is
to zero, the longer term the exponential average becomes.

“exponential_average” Series Constant (Number)
exponential_average (HO, Weight)

Extract Day
This study returns XMIM's mathematical value corresponding to the day as encoded within the software.

where d is the day encoded in XMIM date D. See the entry for “Construct Date” for an explanation.

“extract_day” from Date
extract_day from 1996

Extract Month
This study returns XMIM's mathematical value corresponding to the month as encoded within the software.

where m is the month encoded in the XMIM date D. See the entry for “Construct Date” for an explanation.

“extract_month” from Date
extract_month from 1996

Extract Year
This study returns XMIM's mathematical value corresponding to the year as encoded within the software.

where y is the year encoded in the XMIM date D. See the entry for “Construct Date” for an explanation.

“extract_year” from Date
extract_year from 1996
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Greatest Integer
This study returns a ceiling for a series using the some units specified as “steps”. There are two fields that
are required to be specified within this study- the Attribute or series (this may also be a constant/number or
variable) and step. This study will return a value that is greater or equal to the Attribute and that is a multiple
of the number specified in the steps field. For example, if the Close of US was specified as the Attribute
and ‘2’ was specified in the steps field, the study would return a number that was divisible by 2 and that was
greater than the daily closing price.

“greatest_integer” Series Constant (Number)
greatest_integer (HO, Step)

Highest
Returns the highest value in a data series during a specified period of time.

Identification of a succession of higher highs and higher lows is a technical method commonly used to
designate an uptrend and may be used to identify certain trending patterns within your studies.

This study will ignore any NaN values. If all the X values are NaN, it will return NaN. Otherwise, it will
return the maximum of the non-NaN values.

Constant (Number) Time Period (day/mth/yr) “highest” of Series
1 day highest of HO

If-Then Statement
This language structure lets you assign a  Series  based on time, date, event or price conditions. It creates a
logical structure so that if the condition in the ‘If ’ clause is true, the  Series  represented by the ‘Then’ clause
is assigned on that date.

if Condition then Series endif
if Date is NG expiration_day then HO endif
if HO is more than CL then CL endif
if 1 week % move of HO is more than 10 then 1 week % move of HO endif
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Inverse Log
This study returns the inverse logarithm for a specified Attribute or series.

If X is NaN, its inverseLog is also NaN.

“inverse_log” of Series
Inverse_log of HO

Linear Regression
Returns a value for a given attribute based on a linear regression (fitting data to a line, such as y=ax + b)
over a specified time period. Linear regression is a statistical method of following trends. According to
industry authorities, the results of linear regression studies are quite similar to the moving averages. This study
performs a linear regression over a specified time period.

where  and  are the linear regression coefficients, computed as follows:

The formulas stated above are the standard formulas for linear regression; however, they are not well-suited
to a computer implementation, because they suffer from severe round-off errors. To alleviate this, XMIM
implements the equivalent formulas below instead:
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Note that some of the expressions above are actually simple functions of n, i.e.,

In general, XMIM will pre-compute these expressions, and so the formulas above are greatly simplified
(and largely unrecognizable). LinearRegression ignores any NaN values in X. That is, if 3 values are NaN
in the computation of linearRegression(X, 10), XMIM computes linearRegression(X’ 7) instead, where the
X’ are derived from X by “stripping” away the NaN values. Note in particular that the placement of NaNs
throughout the X time series is not significant.

Constant (Number) Time Period (day/mth/yr) “linear_regression” of Series
1 day linear_regression of HO

Lowest
Returns the lowest value in a data series during a specified period of time. This function is helpful in
identifying lower highs and lower lows, characterizing an downward trend pattern.

This study will ignore any NaN values. If all the X values are NaN, it will return NaN. Otherwise, it will
return the minimum of the non-NaN values.

Constant (Number) Time Period (day/mth/yr) “lowest” of Series
1 day lowest of HO

Macd_osc
This study’s name is short hand for moving average convergence divergence oscillator. This indicator was
developed by Gerald Appel and is widely employed to measure market momentum as well as detecting and
following trends. This study measures the rate of convergence and divergence between two exponentially
smoothed moving averages (or the rate of acceleration or deceleration between a faster or shorter period
moving average and a slower or longer period moving average). There are three fields that must required to
be specified within this study- the Attribute or series and two fields representing the weights for the faster and
slower exponentially smooth moving averages. This study will return the difference between the two moving



72
 

MIMIC USER GUIDE
Chapter 15: Formula Table

averages. A value of ‘0’ would indicate that the averages are exactly the same whereas a positive value (where
the faster average was the first defined weight field) would indicate acceleration and a negative value would
indicate deceleration.

For an explanation of the w 1, w2 and w 3 arguments, see the discussion about “Exponential Average”.

“macd_osc” Series Constant (Number) Constant (Number)
macd_osc (HO, Weight 1 Weight 2)

Macd_signal
This study incorporates a ‘signal’ line into the study, macd_osc, listed above. Where the first two fields
represent the faster and slower moving averages in the macd_osc study, the third weight represents the
exponential weight of this macd_osc study. So in effect this study is an exponential study, as defined by the
third weight, of macd_osc created by the first two weight fields. The basic method of incorporating this study
into a trading program is to look for buy signals when the macd_osc crosses above the macd_signal and to
look for sell signals upon the reverse.

For an explanation of the w 1, w 2, and w 3 arguments, see the discussion about “Exponential Average”.

“macd_signal” Series Constant (Number) Constant (Number) Constant (Number)
macd_signal (HO, Weight 1 Weight 2 Weight 3)

Median
Returns the median value in a data series. Median function first sorts the data series, and then returns the
median value. If the data item number in the series is odd, it returns the middle data item in the series.
Otherwise, it returns the middle two data item average. For example, if the data series is (10, 4, 7), the median
value is 7. If the data series is (10, 2, 3, 27), the median value is (3+10)/2=6.5

This study will ignore any NaN values. If all the X values are NaN, it will return a NaN. Otherwise, it will
return the non-NaN median value.

“median” Constant (Number) Time Period (day/mth/yr) “median” of “Close” of Series
3 day median of Close of CL
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Midpoint or Mid_point
This study returns the mathematical midpoint for a specified Attribute and is calculated by dividing the sum,
of the High of the Attribute and the Low of the Attribute, by 2. A popular method of employing this study is
to gauge a 50% market retracement (as defined as some point below the midpoint), off from some specified
high, as potential entry points for a trading program. The syntax “midpoint” or “mid_point” may be used.

Where X is the High of the Attribute and Y is the Low of the Attribute.

“midpoint” or “mid_point” of Series
midpoint of HO
mid_point of` HO

Move
Returns the difference between the start and end values over a specified time period.

If either X or X n is a NaN, the immediately preceding value will be considered instead, i.e., X  1  or X  n+1 .
If these values are also NaN, the move will be NaN as well. For example, when computing a 2 day move, if X
is a NaN, but X  2  is not, then XMIM will return X  1   – X  2  instead of X – X 2. But, if X  1  is also NaN,
then XMIM will return NaN.

Constant (Number) Time-Period (day/mth/yr) “move” of Series
1 day move of HO

Natural Log
This study returns the natural logarithm for a specified Attribute or series.

If X is NaN or less than or equal to 0, naturalLog returns NaN

“natural_log” of Series
natural_log of HO
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Nearest Integer
This study will return either the smallest integer or the greatest integer, depending upon which value is closest
to the value of the Attribute or series selected. This study may be used to calibrate where the value of the
Attribute is relative to some ceiling (greatest integer) or floor (smallest integer).

or

depending on which of the two values is closer to N. If N is the midpoint of these two values, XMIM
chooses greatestInteger (N, s) arbitrarily.

“nearest_integer” Series Constant (Number)
Nearest_integer (HO Step)

Negative Value
This study will only return the value of the Attribute specified where the value is a negative number. Where
the value is positive or zero the value returned is '0'.

Notice that this function never returns a positive number. If X is NaN, negativeValue returns NaN as well.

“negative_value” of Series
Negative_value of HO

Net Change
This study is the same as the “move study”, but the sign of the change is removed. Net change is the absolute
value of the move.

This study treats NaNs analogously to move. It also performs the same special cases.

Constant (Number) Time-Period (day/mth/yr) “net_change” of Series
1 day net_change of HO
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Net Percent Change
This study returns the absolute value of the percentage move over some time period specified.

This study treats NaNs analogously to move. It also performs the same special cases.

Constant (Number) Time-Period (day/mth/yr) “net_percent_change” of Series
1 day net_percent_change of HO

On Balance Volume
This study quantifies the trend in volume over time and is most closely identified with research conducted by
Joseph Granville. There are several methods by which this study may be analyzed. The primary methods are
trend assessment and divergence analysis. The study returns a cumulative value representing the running total
equated to the sum of (daily or periodic volume multiplied by 1, where the daily or periodic move is positive,
or by -1, where the move is negative). This study is a ‘running’ calculation based on market direction and
volume. The only field required to be specified for the study is the Attribute.

where sign is 1 if Close of S is up and -1 otherwise. The expression onBalanceVolume1(S) refers to the
previous value of onBalanceVolume(S).

“on_balance_volume” of Series
on_balance_volume of HO

Periods in Range
This study returns the number of periods (days, weeks, etc.) in some specified window time. The most
interesting use of this study is to calibrate the number of periods or days between two given conditions. For
example, the periods in range from the time when some value crosses above a moving average to when the
value crosses below. This example could assist in identifying the period of time a certain trade would be active
based on a moving average system.

where #n counts the number of periods (days, weeks, etc.) in the time period n. If this time period is specified
as a from/to range, and the boundaries are reversed (i.e., the “from” occurs after the “to”), periodsInRange
returns a negative number.
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"periods_in_range" Constant (Number) Time Period (day/mth/yr)
periods_in_range 1 day

Positive Value
This study will only return the value of the Attribute specified where the value is a positive number. Where
the value is negative or zero the value returned is ‘0’.

If X is NaN, positiveValue returns NaN as well.

“positive_value” of Series
positive_value of HO

Product
This study will return the product (the multiplication of some values to each other) of those values of an
Attribute as defined over some period of time. Where there exists a holiday or missing data (expressed by
NaN) the equation is multiplied by ‘1’. There are two fields that must be specified within this study- the
Attribute or series and time period.

This study will ignore any values that are NaN. That is, it returns the product of the non-NaN values in the
given range. If all the X values are NaN, product returns a NaN.

“product” Series Time Period (day/mth/yr)
product (HO, day)

Range
This study will return the range for some specified Attribute by subtracting the High of the Attribute - the
Low of the Attribute. Trading ranges, performed for certain key periods (i.e. calendar month or 6 months),
are used to establish the upper and lower boundaries that are essential to defining levels of support and
resistance. Breakouts from established trading ranges provide important trading signals.
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“range” of Series
range of HO

Rel Strength
This study returns the difference between the period percent move of one data series versus another defined
series. This study is useful for attribution analysis (research that defines what portion of a security’s price is
‘attributable’ to the broad market moves). The most interesting use of this study is to compare the price of
a security or market sector versus its comparable broad market index to see whether the security or sector is
outpacing or under-performing the index.

“rel_strength” Sec Series Index Series Constant (Number)
rel_strength (HO, CL, NumDays)

Select Contract
The MIM will adjust all studies using futures contract so that the artificial price jump associated with the
expiration of a contract will not be factored into the study. For example, if a study using the front continuous
contract captured a time period which included a roll or expiration date, by default, that price difference
between the old or expiring contract and the new contract would be subtracted or backed out of the equation
as of the expiration date. The select_contract function is used so that the jump or price difference associated
with expiration (cost of carry) is not adjusted out of the study. This is accomplished by ‘anchoring’ the current
contract that satisfies our expiration requirements (i.e. if the front contract is the March 1998 contract, the
studies will be performed exclusively on this contract and will ignore all previous contracts that meet our
expiration requirement). There are four fields that are required to be specified within this study- the Attribute
or series (select your futures series), the deferred number of the contract chosen (i.e., 1 represents the contract
nearest to expiration or the front contract, 2 represents the second nearest contract to expiration, etc.), the
number of days until expiration that the contract should be followed (i.e., 0 specifies that the contract will be
active until expiration, 1 specifies that the contract will be active or followed up until 1 day before expiration,
etc.) and contract month which is the parameter which specifies the contract month of interest (i.e., setting
the field to 0 will disable this field thereby allowing the contract to roll to the regularly traded serial months,
setting the field to 1 will specify only January contracts, etc.).

where is computed by replacing all references to a relation in X with the corresponding “current” contract.
The current contract is selected as in adjustContract.
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“select_contract” Series Constant (Number) Constant (Number) Constant (Number)
select_contract (HO, DeferredNum, NumDays, ContractMonth)

The following shows further examples to demonstrate the use of select_contract.

Example 1:

Consider the trading day of 10/8/2002 for the following scenarios.

The “prompt” crude oil contract would be Nov 2002, CL_2002X .

Data Table

Date LIM SYMBOL adjust_contract version
10/8/2002 CL_2002Z - Close adjust 1st December contract out

select_contract (CL, 1, 0, 12)
29.51 29.51
CL_2003J - Close adjust 6th contract month out

select_contract (CL, 6, 0, 0)
27.6 27.6
CL_2004H - Close adjust 2nd March contract out

select_contract (CL, 2, 0, 3)
23.86 23.86
CL_2005F - Close adjust 3rd January contract out

select_contract (CL, 3, 2, 1)
23.03 23.03

Let’s look closer at each of these to see how the select_contract function chooses the correct contract.

December 2002 contract: This is the nearest December contract right now. The explicit LIM symbol is
CL_2002Z. To ask for the closest contract month using select_contract you fill in select_contract (CL, 1, 0,
12), where:

● CL = base commodity symbol of choice.

● 1 = N nearest. 3 would imply the 3rd nearest, 6 the 6th nearest.

● 0 = This is “Number of days before Expiration”. Setting this number to “0” indicates the series will locate
the next nearest contract when the contract expires. Setting this number to “4” would mean that the
contract should roll to the next one 4 days before expiration of the current contract.

● 12 = This is the contract month, 12 equals December, 5 equals May, 7 equals July.

Setting this number to “0” makes the parameter inactive, meaning the other parameters will
determine the behavior.
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April 2003 contract: This is the 6th nearest contract out. The explicit LIM symbol is CL_2003J. To ask for the
literal N contract out using select_contract, you fill in select_contract (CL, 6, 0, 0), where:

● CL= base commodity symbol of choice.

● 6 = N nearest. 6 points to the 6th closest or nearest to expiration active contract.

● 0 = This is “Number of days before Expiration”. Setting this to “0” indicates the series will locate the next
nearest contract when the contract expires. Setting this to “4” would mean that the contract should roll to
the next one 4 days before expiration of the current contract.

● 0 = Normally, this is where you put in the contract month. However, since we want the exact 6th closest
contract, this is set to “0”.

March 2004 contract: This is the 2nd nearest March contract. The 1st nearest is the March 2003 contract. The
3rd nearest would be March 2005. To ask for the 2nd nearest March using select_contract, you would fill in
select_contract (CL, 2, 0, 3) where:

● CL = base commodity symbol of choice.

● 2 = 2nd nearest

● 0 = This is “Number of days before Expiration”. Setting this to “0” indicates the series will locate the next
nearest contract when the contract expires.

● 3 = March contract.

January 2005 contract: This is the 3rd nearest January contract. The closest or first nearest would be January
2003. To ask for the 3rd nearest using select_contract, you will fill in select_contract (CL, 3, 2, 1), where:

● CL = base commodity symbol of choice

● 3 = 3rd nearest

● 2 = This is “Number of days before Expiration”. Setting this to “2” indicates the series will roll 2 days
before the contract expires and choose the next 3rd nearest contract.

● 1 = January contract.

Example 2:

   SHOW 
     NGjan: select_contract ( NG, 1, 0, 0 ) 
     NGfeb: select_contract ( NG, 2, 0, 0 ) 
     NGmar: select_contract ( NG, 3, 0, 0 ) 
     avg: 
       (select_contract ( NG, 1, 0, 0 ) + select_contract ( NG, 2, 0, 0 ) + 
        select_contract ( NG, 3, 0, 0 )
       ) / 3 
   WHEN 
       Date is December 
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Simple_rsi
Simple relative strength index is a variation of Welles Wilder's Relative Strength Index indicator and is a
popular overbought-oversold measure. These measures are intended to reflect situations when prices have
risen or fallen too sharply and are thus vulnerable to a market reaction. Wilder's version uses a form of
exponential smoothing where simple_rsi uses a simple moving average. This study compares the relative
strength of prices gains (closes that are higher than the previous day's close) versus price losses (closes
that are lower than the previous day's close) by averaging these values for some specified period of time.
Simple_rsi may be performed for any time period. Wilder originally suggested 14 days, however, technicians
sometimes prefer a shorter/more sensitive period of time such as 5 or 7 days. Industry standards derive the
overbought and oversold indicators at levels that range around 70 (overbought) and 30 (oversold).

where U and D are the average of the 1-period up-and down-moves of X, respectively, over the period n. That
is, U and D are given by

Note in the definition of D that D is always positive, since negativeValue is never positive.

“simple_rsi” Series Constant (Number) Time Period (day/mth/yr)
simple_rsi (HO, 1 day)

Smallest Integer
This study returns the floor for a series using units specified as ‘steps’. There are two fields that are required
to be specified within this study- the Attribute or series (this may also be a constant/number or variable) and
step. This study will return a value that is lesser or equal to the Attribute and that is a multiple of the number
specified in the steps field. For example, if the Close of US was specified as the Attribute and ‘2’ was specified
in the steps field, the study would return a number that was divisible by 2 and that was lesser than or equal to
the daily closing price.
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That is, smallestInteger returns the floor of N using the units in s. For example, smallestInteger (5, 2) is equal
to 4, because 4 is the largest multiple of 2 less than or equal to 5. Similarly, smallestInteger (5.3, .25) is equal to
5.25.

“smallest_integer” Series Constant (Number)
smallest_integer (HO, step)

Standard Deviation
This study provides the standard deviation of a population based on the sample as defined by the values
included in the specified time period. Standard deviation measures the spread from the mean (or measures
how far from the center or mean the data tends to range). This study is a commonly used statistic used to
measure the degree of dispersion in the data.

This corresponds to the standard deviation used for population samples.

Constant (Number) Time Period (day/mth/yr) “standard_deviation” of Series
1 month standard_deviation of HO
1 quarter standard_deviation of (2 * CL)
2 year standard_deviation of 1 day move of HO

Standard Deviation Population
Returns a moving population standard deviation of values in the time period (uses n as a divisor) based on the
population itself, that is, the values in the period.

For efficiency and stability, this formula is actually computed as follows:

Constant (Number) Time Period (day/mth/yr) “standard_deviation_population” of Series
1 day standard_deviation_population of HO



82
 

MIMIC USER GUIDE
Chapter 15: Formula Table

Sum
Returns the sum total of all the values in the series during some specified time period. Holidays and missing
values (expressed as Nan) have no effect on the sum. As with any study, if you want the sum to always include
a set number of periods or days than use the term ‘value’ in lieu of day.

This study will ignore any values that are NaN. That is, it returns the sum of all the non-NaN values in the
period n. If all the X values are NaN, sum returns a NaN.

Constant (Number) Time Period (day/mth/yr) “sum” of Series
1 day sum of HO

True Midpoint
This study is very similar to the 'midpoint' study except ‘High’ is defined as the true High or the greater of
either today’s or yesterday’s High and ‘Low’ is defined as the true Low or lesser of either today’s or yesterday’s
Low. For most days, the true High will be identical to today’s High and the true Low will be identical to
today’s low. The differences, where the previous day’s value is selected, will occur on downside gap days (the
range is below yesterday’s range) or conversely upside gap days (the range is above yesterday’s range). By using
the ‘true’ value, we can factor in the downside or upside gap in price.

where H is the higher of the High of S and the previous Close of S, and L is the lower of the Low of S and
the previous Close of S.

“true_midpoint” of Series
true_midpoint of HO

True Range
The True Range indicator is the greatest of the following:

● The current High less the current Low
● The absolute value of: current High less the previous Close
● The absolute value of: current Low less the previous Close

trueRange(S)?maximum((High-Low), (|High-Close 1 day ago|), (|Low-Close 1 day ago|))
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“true_range” of Series
true_range of HO

Variance
This study returns the statistical variance of a population based on the values specified in the time period.
Variance is the square of the standard deviation, which is a measure of data dispersion. A data series that has
values that are widely dispersed will have a high standard deviation and variance.

We choose to use a different but equivalent formula to compute the above expression, so that it can be
computed in a single pass. The actual formula used is:

In the cases where there are less than two non-NaN values in n, variance returns NaN.

Constant (Number) Time Period (day/mth/yr) “variance” of Series
1 day variance of HO

Wilders_rsi
Returns the Welles Wilder’s Relative Strength Index indicator, a popular overbought-oversold measure. This
study is very similar to simple_rsi, except Wilder’s version uses a form of exponential smoothing where
simple_rsi uses a simple moving average.

This study compares the relative strength of prices gains (closes that are higher than the previous day’s close)
versus price losses (closes that are lower than the previous day’s close) by using an exponentially smooth
average of these values for some specified period of time.

Like simple_rsi, wilders_rsi may be performed for any time period. Wilder originally suggested 14 days,
however, technicians sometimes prefer a shorter/more sensitive period of time such as 5 or 7 days. This study
will range between 0 and 100.

Industry standards derive the overbought and oversold indicators at levels that range around 70 (overbought)
and 30 (oversold).
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where U and D are the exponential average of the 1-period up-and down-moves of X, respectively, using the
weight w. That is, U and D are given by

For an explanation of the weight w, see the discussion in “Exponential Average”.

“wilders_rsi” Series Constant (Number)
wilders_rsi (HO, weight)

Williamsr
This study is a momentum indicator and is used to calibrate the position of the Close relative to the High for
some period. Successive values of 100 for the study may indicate an upward trend since the price of a series
closes at its High. Conversely, successive values of 0 may indicate a downward trend since the price of the
series closes at its Low.

“williamsr” of Series
williamsr of HO

Formulas for Server Macros

When creating formulas with server macros, use the symbol names. Using Row Labels with
server macros when constructing formulas is not supported.

_CoolingDegreeDays
Originally designed to evaluate energy demand and consumption, degree days are based on how far the
average temperature departs from a human comfort level of 65 °F *. Simply put, each degree of temperature
above 65 °F is counted as one “cooling degree day”. For example, a day with an average temperature of 80 °F
will have 15 cooling degree days. Source: www.weather2000.com/dd_glossary.html.

http://www.weather2000.com/dd_glossary.html
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_CoolingDegreeDays (Series)

Example:

The Series input is always the symbol for a city.

   SHOW 
     cdd: _CoolingDegreeDays ( HOUSTON.TX )  
   WHEN 
       Date is August 

The query above will calculate the daily cooling degree days during the month of August in Houston,TX . As
you can see it gets quite warm.

“_CoolingDegreeDays” City
_CoolingDegreeDays (HOUSTON.TX)

_HeatingDegreeDays
Originally designed to evaluate energy demand and consumption, degree days are based on how far the
average temperature departs from a human comfort level of 65 °F*. Simply put, each degree of temperature
below 65 °F is counted as one “heating degree day”. For example, a day with an average temperature of 60 °F
will have 5 heating degree days. Source: www.weather2000.com/dd_glossary.html.

_HeatingDegreeDays (Series)

Example:

The Series input is always the symbol for a city.

   SHOW 
     hdd: _HeatingDegreeDays ( CHICAGO.OHARE.IL )  
   WHEN 
       Date is February

The query above will calculate the daily heating degree days during the month of February in Chicago,IL .
Bring a jacket!

“_HeatingDegreeDays” City
_HeatingDegreeDays (CHICAGO.OHARE.IL)

http://www.weather2000.com/dd_glossary.html
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_OffPeakAverage
This macro is designed to calculate the Off Peak Average as it relates to hourly power prices. Many ISO data
feeds are available from LIM. (PJM, NYISO, NEPOOL, IMO, and many European ones as well).

_OffPeakAverage (Series)

Example:

The Series input will be the symbol for a particular zone/node. Run this using “hourly”
execution units.

   SHOW 
     1: _OffPeakAverage ( PJM.WESTERNHUB.HUB.RT )  
   WHEN 
       Date is within 1 week

The query above will calculate the Off Peak Average for the real-time LMP prices on the Western Hub area of
PJM. There are some assumptions being made in the calculation. These have been collected from the industry
and seem to be standard. Namely, on NERC holidays the Off Peak Average uses all hours in the day. On
normal days (non-NERC holidays) hours 1-7 and hour 24 is used in the calculation.

“_OffPeakAverage” Series
_OffPeakAverage (PJM.WESTERNHUB.HUB.RT)

_OnPeakAverage
This macro is designed to calculate the On Peak Average as it relates to hourly power prices. Many ISO
datafeeds are available from LIM. (PJM, NYISO, NEPOOL, IMO, and many European ones as well).

_OnPeakAverage (Series)

Example:

The Series input will be the symbol for a particular zone/node. Run this using “hourly”
execution units.

   SHOW 
     1: _OnPeakAverage ( NYISO_DUNWOD_TWRT )  
   WHEN 
       Date is within 3 weeks 
     AND 
       Date is from Monday  to Friday  
     AND 
       Time is 03:00 pm
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The query above will calculate the On Peak Average for the real-time LMP prices in ZONE I (Dunwoodie)
of NYISO. There are some assumptions being made in the calculation. These have been collected from the
industry and seem to be standard. The On Peak average is calculated during Monday to Friday only. Hours
8 – 23 are considered in the average. Notice that you can have 1 number per day returned if you anchor the
WHEN condition with a time. This is only an anchor and will not affect the results of the query.

“_OnPeakAverage” Series
_OnPeakAverage (NYISO_DUNWOD_TWRT)

These macros below ( _2x8Average through _7x16Average) will only be relevant when looking at intraday
data (e.g. hourly) in the electricity markets. The typical sources of this data from LIM are the Independent
System Operators (ISO’s) in North America, which include PJM, (Pennsylvania Jersey Maryland), NYISO
(New York), NEISO (New England) and MISO (Midwest) – in particular the macros will only work in
those markets that use LMP pricing methods. The user should note that different US regions have different
concepts of peak and off-peak and that generally speaking, the Western region treats Saturday as a peak
period and the Eastern region does not.

These types of calculation may also be relevant for European Electricity markets with intra-day pricing as
well, although definitions of peak and off-peak pricing again will vary by region.

_2x8Average
This macro is designed to calculate the average for Saturday and Sunday from 12am – 6pm and 11pm.

_2x8Average (Series)

Example:

The Series input will be the symbol for a particular zone/node. The column “lmpVal” is assigned
to each Series in the macro script. Therefore only symbols with the column, LmpVal can be used
in this macro. Run this using “hourly” execution units.

   SHOW 
     1: _2X8Average ( A418.138KV.TR7212.PJMRT )  
   WHEN 
       Date is within 1 week  

The query above will calculate the average for hours 1-7 and hour 24 on Saturday and Sunday for the real-
time LMP prices for the Pnode ID: 32408579 for PJM. Notice in the macro code below, there are some
assumptions being made in the calculation. These have been collected from industry and seem to be standard.

“_2x8Average” Series
_2x8Average (A418.138KV.TR7212.PJMRT)

Macro Code:
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ATTR MACRO _2X8Average ( SECURITY PricePoint)  
RETURN 
IF Date is Saturday
OR Date is Sunday
THEN average from 12:00 am to 11:00 pm of 
IFTime is from 12:00 am to 06:00 am 
OR Time is 11:00 pm 
THEN lmpval of PricePoint ENDIF ENDIF
ENDMACRO               

_2x16Average
This macro is designed to calculate the average for Saturday and Sunday from 7am – 10pm.

_2x16Avaerage (Series)

Example:

The Series input will be the symbol for a particular zone/node. The column “lmpVal” is assigned
to each Series in the macro script. Therefore only symbols with the column, LmpVal can be used
in this macro. Run this using “hourly” execution units.

   SHOW 
     1: _2X16Average ( NEPOOL.Z.CONNECTICUT.DA )  
   WHEN 
       Date is within 3 months 
     AND 
       Time is 04:00 pm 
     AND 
       Date is from Saturday  to Sunday
  

The query above will calculate the average for hours 8-23 on Saturday and Sunday for the real-time LMP
prices for the New England ISO LMP LOAD ZONE Day Ahead Market. Notice in the macro code below,
there are some assumptions being made in the calculation. These have been collected from industry and seem
to be standard.

“_2x16Average” Series
_2x16Average ( NEPOOL.Z.CONNECTICUT.DA )

Macro Code:

ATTR MACRO _2X16Average ( SECURITY PricePoint)  
RETURN  
IF Date is Saturday
OR Date is Sunday
THEN average from 07:00 am to 10:00 pm of lmpval of  
PricePoint ENDIF
ENDMACRO
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_5x8Average
This macro is designed to calculate the average for Monday through Friday from 12am-6am and 11pm.

_5x8Average (Series)

Example:

The Series input will be the symbol for a particular zone/node. The column “lmpVal” is assigned
to each Series in the macro script. Therefore only symbols with the column, LmpVal can be used
in this macro. Run this using “hourly” execution units.

   SHOW 
     1: _5X8Average ( NYISO_GENESE_DA )  
   WHEN 
       Date is within 2 years 
     AND 
       Date is from Monday  to Friday  
  

The query above will calculate the average for hours 1-7 and hour 24 Monday thru Friday for the real-time
LMP prices for the NYISO Load Zone Genesee Real Time Market. Notice in the macro code below, there
are some assumptions being made in the calculation. These have been collected from industry and seem to be
standard.

“_5x8Average” Series
_5x8Average ( NYISO_GENESE_DA )

Macro Code:

ATTR MACRO _5X8Average ( SECURITY PricePoint)  
RETURN
IF Date is from Monday  to Friday
THEN average from 12:00 am to 11:00 pm of IF
Time is from 12:00 am to 06:00 am 
OR
Time is 11:00 pm
THEN lmpval of PricePoint 
ENDIF
ENDMACRO
               

_5x16Average
This macro is designed to calculate the average for Monday through Friday from 7am – 10pm.

_5x16Average (Series)

Example:
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The Series input will be the symbol for a particular zone/node. The column “lmpVal” is assigned
to each Series in the macro script. Therefore only symbols with the column, LmpVal can be used
in this macro. Run this using “hourly” execution units.

   SHOW 
     1: _5X16Average ( DELAWARECT11.AGGREGATE.PJMDA )  
   WHEN 
       range of DELAWARECT11.AGGREGATE.PJMDA  is less than 0.25 
     AND 
       Date is from Monday  to Friday  

The query above will calculate the average for hours 8-23 on Monday through Friday for the real-time LMP
prices for the Day Ahead Locational Marginal Price in Delaware. Notice in the macro code below, there are
some assumptions being made in the calculation. These have been collected from industry and seem to be
standard.

“_5x16Average” Series
_5x16Average ( DELAWARECT11.AGGREGATE.PJMDA )

Macro Code:

ATTR MACRO _5X16Average ( SECURITY PricePoint) 
RETURN
IF Date is from Monday  to Friday
THEN average from 07:00 am to 10:00 pm of lmpval of
PricePoint
ENDIF 
ENDMACRO

_7x8Average
This macro is designed to calculate the average for Monday through Friday from 12am-6am and 11pm.

_7x8Average (Series)

Example:

The Series input will be the symbol for a particular zone/node. The column “lmpVal” is assigned
to each Series in the macro script. Therefore only symbols with the column, LmpVal can be used
in this macro. Run this using “hourly” execution units.

   SHOW 
     1: _7X8Average ( NYISO_ALLEGHENY_COGEN_DA )  
   WHEN 
       Date is before 7/27/2001 

The query above will calculate the average for hours 1-7 and hour 24 on Sunday thru Saturday for the real-
time LMP prices for the NYISO Generator ALLEGHENY___COGEN Real Time Market . Notice in the
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macro code below, there are some assumptions being made in the calculation. These have been collected from
industry and seem to be standard.

“_7x8Average” Series
_7x8Average ( NYISO_ALLEGHENY_COGEN_DA )

Macro Code:

ATTR MACRO _7X8Average ( SECURITY PricePoint) 
RETURN
average from 12:00 am to 11:00 pm of IF
{Time is from 12:00 am to 06:00 am
OR 
Time is 11:00 pm}
THEN lmpval of PricePoint
ENDIF
ENDMACRO

_7x16Average
This macro is designed to calculate the average for Monday through Friday from 7am – 10pm.

_7x16Average (Series)

Example:

The Series input will be the symbol for a particular zone/node. The column “lmpVal” is assigned
to each Series in the macro script. Therefore only symbols with the column, LmpVal can be used
in this macro. Run this using “hourly” execution units.

   SHOW 
     1: _7X16Average ( NEPOOL.LD.ASHCREEK115.DA )  
   WHEN 
       Date is 1 week before  any holiday

The query above will calculate the average for hours 8-23 on Sunday through Saturday for the real-time LMP
prices for the New England ISO LMP NETWORK NOD Day Ahead Market. Notice in the macro code
below, there are some assumptions being made in the calculation. These have been collected from industry
and seem to be standard.

“_7x16Average” Series
_7x16Average ( NEPOOL.LD.ASHCREEK115.DA )

Macro Code:

ATTR MACRO _7X16Average ( SECURITY PricePoint)
RETURN  
average from 07:00 am to 10:00 pm of lmpval of
PricePoint  
ENDMACRO 
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AccDist
The Accumulation/Distribution is a momentum indicator that associates changes in price with the daily
range. Divergences between the Accumulation/Distribution and the security’s price imply a change is
imminent. When a divergence does occur, prices usually change to confirm the Accumulation/Distribution.
For example, if the indicator is moving up and the security’s price is going down, prices will probably reverse
and start going up. If the days price change is positive then the difference in the daily high and low price is
added to the total, and conversely if the daily change is negative then the daily range is subtracted from the
total.

AccDist (Series)

Example:

“AccDist” Series
AccDist (DELL)

Macro Code:

COLUMN MACRO AccDist ( SECURITY Sec )
    RETURN
        Sum from begin_of_time to today of
          if Close of Sec > Close of Sec 1 unit ago then
               absolute_value ( Close of Sec -
                   if Low of Sec < Close of Sec 1 unit ago
                                then Low of Sec
                                else Close of Sec 1 unit ago
                            endif )
         else
               if Close of Sec < Close of Sec 1 unit ago then
                   0 - 
                   absolute_value ( Close of Sec -
                                 if High of Sec > Close of Sec 1 unit ago
                                    then High of Sec
                                    else Close of Sec 1 unit ago
                                 endif )
               else
               0
            endif
       endif
ENDMACRO

Aspect
Returns the difference in ecliptic longitude degrees between any two planets (except Earth). Choose planets
(including Sun & Moon) relations from the “Other: Astronomy” menu in the Search Database window.

Aspect (Planet1, Planet2)

Example:

Aspect (MERCURY, SATURN)
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“Aspect” Planet 1 Planet 2
Aspect (MERCURY, SATURN)

AspectEquatorial
Returns the difference in equatorial right ascension between any two planets (except Earth, the Sun, or the
Moon).

AspectEquatorial (Planet1, Planet2)

Example:

AspectEquatorial (MERCURY, SATURN)

“AspectEquatorial” Planet 1 Planet 2
AspectEquatorial (MERCURY, SATURN)

AspectHelio
Returns the difference in heliocentric longitude between any two planets.

AspectHelio (Planet1, Planet2)

Example:

AspectHelio (MERCURY, SATURN)

“AspectHelio” Planet 1 Planet 2
AspectHelio (MERCURY, SATURN)

AspectPlot
The following are all used in the same manner. These all plot vertical lines on the chart on days when any
astrological aspect is in force. Astrologers are especially interested in the locations of solar system objects
relative to other solar system objects - numbers called “aspect” angles with the centers of the Earth or Sun
(depending on which coordinate system, geocentric or heliocentric, is used) located at the vertex of the
measured angle. Significant aspect angles have names associated with them listed below in order of supposed
importance and influence, along with the Orb - the number of degrees of tolerance often used with the
aspect, and the usual symbols used to denote the angles in printed Ephemeris tables.

No. Glyphs Aspect Abbrev. Aspect Angle Orb (tolerance) Description of Standard
1 Conjunct (Con) 0.00 +/-7 deg. Circle with extending line
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No. Glyphs Aspect Abbrev. Aspect Angle Orb (tolerance) Description of Standard
2 Opposite (Opp) 180.00 +/-7 deg. Two circles joined by line
3 Square (Squ) 90.00 +/- 7 deg. Quadrilateral
4 Trine (Tri) 120.00 +/- 7 deg. Triangle
5 Sextile (Sex) 60.00 +/- 6 deg. Six pointed asterisk
6 Inconjunct (Inc) 150.00 +/- 3 deg. 'K' rotated clockwise
7 Semisextile (Ssx) 30.00 +/- 3 deg. 'K' rotated counter-clockwise
8 Semisquare (Ssq) 45.00 +/- 3 deg. Acute angle
9 Sesquisquare (Ses) 135.00 +/- 3 deg. Square with extending lines

Minor Aspects (not included in macro set - use “AspectX” macros which let you specify any arbitrary aspect
angle.)

PlotAspectX
Plots vertical lines on the chart on days when any astrological aspect is in force.

PlotAspectX (Planet1, Planet2, aspect, orb)

Example:

PlotAspectX (MARS, NEPTUNE, 90, 0)

“PlotAspectX” Planet 1 Planet 2 Aspect (Number) Orb (Number)
PlotAspectX (MARS, NEPTUNE, 90, 0)

The following are all used in the same manner:

PlotConjunct
PlotInconjunct
PlotOpposite
PlotSemisextile
PlotSemisquare
PlotSesquisquare
PlotSextile
PlotSquare
PlotTrine

These all plot vertical lines on the chart on days when any astrological aspect is in force.

Example:

PlotConjunct (SATURN, MARS, 0)

“PlotConjunct” Planet 1 Planet 2 Orb (Number)
PlotConjunct (SATURN, MARS, 0)
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BackContract
Returns the price of the back contract. This functionality is now built into the language itself. The default
selection for a parent futures contract (i.e., US) is the front continuous contract. The button labeled
‘continuous’ located directly above the Symbol Browser may be toggled to ‘back’ to perform the same feature.
This macro is included for backward compatibility with older versions of the XMIM software.

BackContract (Series, NumDays, ContractMth)

Example:

BackContract (NG, 0, 0)

“BackContract” Series NumDays (Number) ContractMth (Number)
BackContract (HO, 1, 1)

BlackScholesOptionPrice
Computes the option price based on the Black Scholes model for a European option. The interest rate must
be expressed as a decimal fraction. For example, 2% will be 0.02. The sigma argument must also be expressed
as decimal fraction: e.g. 16% is 0.16. The days to expiration are in actual days and will be divided by 365 to
convert to fractions of a year. For a 252 day year adjust the days input by 252/365.

BlackScholesOptionPrice (@underlying_price, @strike, @interest_rate, @sigma, @days_expiration, @is_call)

Example:

BlackScholesOptionPrice ( Close of SP_2004Z, 1100,FRH_DGS1 / 100,
(30 day std_dev of Close of SP_2004Z) / 100,
periods_in_range from today to SP_2004Z.C1100 last_data_day, 1 )

@underlying_price @strike @interest_rate @sigma @days_expiration @is_call
Close of SP_2004Z, 1100, FRH_DGS1/100, (30 day std_dev

of Close of
SP_2004Z) / 100,

periods_in_range from
today to SP_2004Z.C1100
last_data_day,

1

ChannelIndex
Returns an index of bollinger bands, a statistical version of the stochastic.

Donald Lambert developed this price momentum indicator - Commodity Channel Index (CCI). It shows how
the most recent close relates to the standard deviation range over the recent time period.

ChannelIndex (Series, TimePeriod)

Example:
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ChannelIndex (SP, 22 days)

“ChannelIndex” Series Constant (Number) Time Period (day/mth/yr)
ChannelIndex (HO, 22 days)

ChoppinessIndex
Returns an indicator that measures the sum of all the ranges in a time period to the range over the time period
as a measure of the trendiness or choppiness of a price series. Inspired by chaos theory, it is similar to Wilder’s
Directional Movement Index but with simpler calculations and less lag. The Choppiness Index varies between
0 and 100, the higher the index the choppier the price action is and the lower the index the more trending the
price action

ChoppinessIndex (Series, TimePeriod)

Example:

ChoppinessIndex (JY, 10 days)

“ChoppinessIndex” Series Constant (Number) Time Period (day/mth/yr)
ChoppinessIndex (HO, 22 days)

DeMarker
Returns Tom DeMark’s Oscillator. The DeMarker identifies potential price bottoms and tops. The indicator
fluctuates between 0 and 1.

DeMarker (Series, TimePeriod)

Example:

DeMarker (Close of SPX, 15 days)

“DeMarker” Attribute of Series Constant (Number) Time Period (day/mth/yr)
DeMarker (Close of HO, 22 days)

DeferredContract
This study provides a generalized macro for dealing with futures contracts. The DeferredContract function is
used to identify certain back contract relationships within the software.

There are two methods to identify a futures contract:
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1. You may identify the ‘specific’ contract (i.e., the March 1998 30 year U.S. Treasury Bond contract or
US_1998H)

2. You may identify a ‘generic’ contract based upon the contracts expiration (i.e., the front continuous
adjusted 30 year U.S. Treasury Bond contract or US). If a user wanted to test a trading strategy that
involved the sixth contract on the board, or some contract expiring later than the front, far and back
contracts (these selections are available under the ‘continuous’ button above the Symbol Browser),
DeferredContract would be used to define contract.

There are four fields that are required to be specified within this study:

1. The Attribute or series (select your futures series).

2. The deferred number of the contract chosen (i.e., 1 represents the contract nearest to expiration or the
front contract, 2 represents the second nearest contract to expiration, etc.).

3. The number of days until expiration that the contract should be followed (i.e., 0 specifies that the contract
will be active until expiration, 1 specifies that the contract will be active or followed up until 1 day before
expiration, etc.).

4. Contract month that is the parameter that specifies the contract month of interest (i.e., setting the field to
0 will disable this field thereby allowing the contract to roll to the regularly traded serial months, setting
the field to 1 will specify only January contracts, etc.).

DeferredContract (Series, DeferredNum, NumDays, ContractMth)

Example 1:

DeferredContract (US, 3, 0, 0)

“DeferredContract” Attribute Deferred Number NumDays till expire (Number) Contract Month (Number)
DeferredContract (US, 3, 0, 0)

The following shows further examples to demonstrate the use of DeferredContract.

Example 2:

As the macro code below shows, the deferred contract macro is using the adjust_contract built-in. Therefore,
the properties that are required entry for the adjust contract are the same for the deferred contract.

Assuming the 10/8/2002 trade date, the prompt/front contract for the NYMEX natural gas futures is the
November 2002 contract (NG_2002X). If we wanted to use the deferred contract macro to modify the
continuous NG contract to show the 5th contract out instead of the prompt contract, we could use the
following syntax:

   SHOW 
     1: DeferredContract ( NG, 5, 0, 0 )

This will modify NG to the 5th contract out. (Prompt +4). This will now show the price for the March 2003
NG contract. (NG_2003H)
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● NG= base commodity symbol of choice.
● 5 = N nearest. 5 points to the 5th closest or nearest to expiration active contract.
● 0 = This is “Number of days before Expiration”. Setting this to “0” indicates the series will locate the next

nearest contract when the contract expires. Setting this to “4” would mean that the contract should roll to
the next one 4 days before expiration of the current contract.

● 0 = Normally, this is where you put in the contract month. However, since we want the exact 6th closest
contract, this is set to “0”.

*Any of the 4 parameters can be modified to adjust the continuous contract as described in the
adjust_contract built-in definition.

Here is an example of the data:

      Date    Day    Deferred      NG_2003H
 10/08/2002   Tue      4.023         4.023

Example 3:

   SHOW 
     twoSixAvg: 
       (DeferredContract ( NG, 2, 0, 0 )  + DeferredContract ( NG, 3, 0, 0 )  
        + DeferredContract ( NG, 4, 0, 0 )  + DeferredContract ( NG, 5, 0, 
        0 )  + DeferredContract ( NG, 6, 0, 0 ) 
       ) / 5 
     frontNG: NG 
   WHEN 
       Date is within 2 years 
     AND 
       NG is DEFINED

Macro Code:

ATTR MACRO DeferredContract ( ATTR Series, CONSTANT DeferredNum = 1,
                      CONSTANT NumDays = 0, CONSTANT ContractMth = 0 )
    RETURN
      adjust_contract ( Series, DeferredNum, NumDays, ContractMth )
ENDMACRO

DirMove
DirMove returns the Welles Wilder’s Directional Movement indicator. To be used in conjunction with
DirMoveIdx (below), which returns the Welles Wilder’s Directional Movement Index. DirMove uses an
exponential average in its calculation, while DirMoveIdx uses simple moving average.

Example:

DirMove (Close of MSFT, 0.071428571)

“DirMove” Attribute of Series Constant Weight
DirMove (Close of HO, 0.071428571)
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DirMoveIdx
Returns the Welles Wilder's Directional Movement Index.

Example:

DirMoveIdx (Close of INTC, 78 days)

“DirMoveIdx” Attribute of Series Constant (Number) Time Period (day/mth/yr)
DirMoveIdx (Close of HO, 78 days)

FarContract
Returns the price of the third nearest-to-delivery futures contract in a futures market. This functionality is
now built into the language itself. The default selection for a parent futures contract (i.e., US) is the front
continuous contract. The button labeled ‘continuous’ located directly above the Symbol Browser may be
toggled to ‘far’ to perform the same feature. This macro is included for backward compatibility with older
versions of the XMIM software.

FarContract (Series, NumDays, ContractMth)

Example 1:

FarContract (Close of CL, 4, 11)

“FarContract” Attribute of Series NumDays (Number) ContractMth (Number)
FarContract (Close of HO, 4, 11)

Example 2:

As the macro code below shows, The FarContract macro is using the adjust_contract built-in. Therefore, the
properties that are required entry for the adjust contract are the same for the far contract with the exception
of the second adjust_contract parameter which indicates the N month out. This is always set to 3.

A user can utilize the FarContract macro to modify a continuous contract to pull the far (3rd) closest contract
to expiration.

Assuming the 10/8/2002 trade date, the prompt/front contract for the NYMEX natural gas futures is the
November 2002 contract (NG_2002X). If we wanted to use the FarContract macro to modify the continuous
NG contract to show the 3rd contract out instead of the prompt contract, we could use the following syntax:

   SHOW 
     1: FarContract ( NG, 0, 0 )

This will always modify NG to the 3rd contract out. (Prompt +2). This will now show the price for the
January 2003 NG contract. (NG_2003F).

● NG= base commodity symbol of choice.
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● 0 = This is “Number of days before Expiration”. Setting this to “0” indicates the series will locate the next
nearest contract when the contract expires. Setting this to “4” would mean that the contract should roll to
the next one 4 days before expiration of the current contract.

● 0 = Normally, this is where you put in the contract month. However, since we want the exact 6th closest
contract, this is set to “0”.

*Any of the 3 parameters can be modified to adjust the continuous contract as described in the
adjust_contract built-in definition.

Here is an example of the data:

      Date    Day      Far   NG_2003F
10/08/2002    Tue    4.243      4.243

Example 3:

   SHOW 
     macro: FarContract ( CL, 0, 0 )  
     xmimlanguage: far CL 
   WHEN 
       Date is 2001 

Macro Code:

ATTR MACRO FarContract (ATTR Series, CONSTANT NumDays = 0,
                   CONSTANT ContractMth = 0)
 RETURN
       adjust_contract (Series, 3, NumDays, ContractMth)
ENDMACRO

FrontContract
Returns the price of the nearest-to-delivery futures contract in the futures market. This functionality is
now built into the language itself. The default selection for a parent futures contract (i.e. US) is the front
continuous contract. The button labeled ‘continuous’ located directly above the Symbol Browser may be
toggled to ‘front’ to perform the same feature. This macro is included for backward compatibility with older
versions of the XMIM software.

FrontContract (Series, NumDays, ContractMth)

Example 1:

FrontContract (Close of NG, 4, 11)

“FrontContract” Attribute of Series NumDays (Number) ContractMth (Number)
FrontContract (Close of HO, 4, 11)

Example 2:

As the macro code below shows, the FrontContract macro is using the adjust_contract built-in. Therefore,
the properties that are required entry for the adjust contract are the same for the FrontContract macro with



MIMIC USER GUIDE
Chapter 15: Formula Table

101
 

the exception of the second adjust_contract parameter which indicates the N month out. This is always set to
1.

A user can utilize the FrontContract macro to modify a continuous contract to pull the prompt or closest
contract to expiration.

Assuming the 10/8/2002 trade date, the prompt/front contract for the NYMEX natural gas futures is the
November 2002 contract (NG_2002X). If we wanted to use the FrontContract macro to pull the front
contract, we could use the following syntax:

    SHOW 
     Front: FrontContract ( NG, 0, 0 )  

This will always modify NG to the front contract (Prompt). This will now show the price for the November
2002 NG contract. (NG_2002X)

● NG= base commodity symbol of choice.
● 0 = This is “Number of days before Expiration”. Setting this to “0” indicates the series will locate the next

nearest contract when the contract expires. Setting this to “4” would mean that the contract should roll to
the next one 4 days before expiration of the current contract.

● 0 = Normally, this is where you put in the contract month. However, since we want the exact 6th closest
contract, this is set to “0”.

*Any of the 3 parameters can be modified to adjust the continuous contract as described in the
adjust_contract built-in definition.

Here is an example of the data:

      Date        Day      Front    NG_2002X
10/08/2002        Tue      3.862       3.862

Example 3:

   SHOW 
     macro: FrontContract ( US, 0, 0 )  
     xmimlanguage: front US 
   WHEN 
       Date is 2002

Macro Code:

ATTR MACRO FrontContract (ATTR Series, CONSTANT NumDays = 0,
  CONSTANT ContractMth = 0)
    RETURN
adjust_contract (Series, 1, NumDays, ContractMth)
ENDMACRO

HistVolLog
Returns the historical volatility of a series: the standard deviation of the logarithmic price changes measured at
regular intervals of time. The default time period is 20 days. The default number of units per year is 250.
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HistVolLog (Series, NumUnits, UnitsPerYear)

Example:

HistVolLog (Close of front CL, 20 days, 250)

“HistVolLog” Attribute of Series NumUnits
(Number)

Time Period
(day/mth/yr)

UnitsPer Year
(Number)

HistVolLog (Close of HO, 20 days, 250)

HistVolPct
Returns the historical volatility of a series: the standard deviation of the percent price changes measured at
regular intervals of time. The default time period is 20 days. The default number of units per year is 250.

HistVolPct (Series, NumUnits, UnitsPerYear)

Example:

HistVolPct (Close of front NG, 20 days, 250)

“HistVolPct” Attribute of Series NumUnits
(Number)

Time Period
(day/mth/yr)

UnitsPer Year
(Number)

HistVolPct (Close of HO, 20 days, 250)

MoneyFlowIndex
The Money Flow Index measures the amount of money flowing in and out of a security. It is an oscillator not
unlike RSI that incorporates Volume into its calculation. The values range between 0 and 100. Market tops
generally occur around 80 and bottoms around 20.

MoneyFlowIndex (Series, TimePeriod)

“MoneyFlowIndex” Series NumUnits (Number) Time Period (day/mth/yr)
MoneyFlowIndex (HO, 50 days)

NegVolIndex
Returns an accumulated sum of the close-to-close percent moves of the security when the volume is lower
than the volume one period ago.
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NegVolIndex (Series)

Example:

NegVolIndex (INTC)

“NegVolIndex” Series
NegVolIndex (HO)

NetHedgers
Returns the net open interest held by traders in the commercial hedgers category of futures traders in a
market. The calculation is net long minus net short positions.

NetHedgers (Series)

Example:

NetHedgers (NG)

“NetHedgers” Futures Contract
NetHedgers (HO)

NetHedgersPct
Returns the net open interest holdings of the commercial hedger category as a percentage of total open
interest in the market.

NetHedgersPct (Series)

Example:

NetHedgersPct (SP)

“NetHedgersPct” Futures Contract
NetHedgersPct (HO)

NetLargeSpecs
Returns the net open interest held by traders in the large speculator category of futures traders in a market.
That is, the net long minus net short positions.
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NetLargeSpecs (Series)

Example:

NetLargeSpecs (JY)

“NetLargeSpecs” Futures Contract
NetLargeSpecs (HO)

NetLargeSpecsPct
Returns the net open interest holdings of the large speculator category as a percentage of total open interest
in the market.

NetLargeSpecsPct (Series)

Example:

NetLargeSpecsPct (US)

“NetLargeSpecsPct” Futures Contract
NetLargeSpecsPct (HO)

NetSmallTraders
Returns the remaining net open interest held by traders with positions smaller than reporting thresholds.

NetSmallTraders (Series)

Example:

NetSmallTraders (HO)

“NetSmallTraders” Futures Contract
NetSmallTraders (HO)

NetSmallTradersPct
Returns the net open interest of the Small Traders category as a percentage of total open interest.

NetSmallTradersPct (Series)
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Example:

NetSmallTradersPct (HO)

“NetSmallTradersPct” Futures Contract
NetSmallTradersPct (HO)

NormalDist
NormalDist(n) returns the percent of area under the normal distribution curve commonly called the z-table.
The parameter n is the number of standard deviations from the mean. The macro NormalDist(n) returns the
percent of the curve below parameter n. This is commonly used to compute probability.

Example:

NormalDist (5)

“NormalDist” Number of Standard Deviations from the Mean (Number)
NormalDist (5)

RangeExpIndex
Returns Tom DeMark's REI2 indicator as explained in his book “The New Science of Technical Analysis”.

RangeExpIndex (Series, TimePeriod)

Example:

RangeExpIndex (GE, 15 days)

“RangeExpIndex” Series Constant (Number) Time Period (day/mth/yr)
RangeExpIndex (HO, 15 days)

RealSum
Here Counter is a number which is the # of days to start the look back. Returns the sum of the last N days.

RealSum (Attribute, Counter)

Example:

RealSum (DELL, 3 )
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is the same as

sum from 2 days ago to today of DELL

Both are considering 3 days of data for the calculation.

“RealSum” Series Counter (N) (Number)
RealSum (HO, 3)

Stochastics

KStochastic
Stochastics is a momentum or price velocity indicator developed by George C. Lane. This macro is sometimes
referred to as "%K" in the market. This is the normal stochastic.

KStochastic (Security, TimePeriod)

Example:

KStochastic (DELL, 18 days)

“KStochastic” Series Constant (Number) Time Period (day/mth/yr)
KStochastic (HO, 18 days)

SDStochastic
This macro is an average of the "SKStochastic" macro.

SDStochastic (Security, TimePeriod, TimePeriod2)

Example:

SDStochastic (MPPP, 24 days, 10 days, 6 days)

“SDStochastic” Series Constant
(Number)

Time
Period1

Constant
(Number)

Time
Period2

Constant
(Number)

Time
Period3

SDStochastic (HO, 24 days, 10 days, 6 days)

SKStochastic
This macro is sometimes referred to as "%D" in the market. It is the slower moving stochastic.

SKStochastic (Security, TimePeriod, TimePeriod2)
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Example:

SKStochastic (OAT, 14 days, 4 days)

“SKStochastic” Series Constant
(Number)

Time Period1
(day/mth/yr)

Constant
(Number)

Time Period2
(day/mth/yr)

SKStochastic (HO, 14 days, 4 days,

Trendline
Returns drawing of a line to connect a series of peaks or troughs on a Chart. Both uptrends and downtrends
in a market can be defined in terms of trendlines.

Trendline (Price1, Date1, Price2, Date2)

“Trendline” Price 1 Date 1 Price 2 Date 2
Trendline (21.20, 1/1/2001 17.85, 2/3/2002)

VolPriceTrend
Returns an index which takes the distance of the close of the day from the midpoint of the day, multiplies that
times the volume and sums the results over time.

VolPriceTrend (Series, TimePeriod)

Example:

VolPriceTrend (DELL, 68 days)

“VolPriceTrend” Sec Series Constant (Number) Time Period (day/mth/yr)
VolPriceTrend (HO, 68 days)

Volatility
Returns the high of the period divided by the low.

Volatility (Series)

Example:

Volatility (RAD)
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“Volatility” Sec Series
Volatility (HO)

VolatilityIdx
Returns the exponential moving average of the true range.

Refer to Exponential Average notes for weight info.

VolatilityIdx (Security, Weight)

Example:

VolatilityIdx (IO, 0.0714)

“VolatilityIdx” Sec Series Weight
VolatilityIdx (HO, 0.0714)

WildersADX
The familiar average directional movement index is simply the directional movement index (WildersDX)
averaged for the time period chosen for study related to the previous day’s average directional movement
index.

WildersADX (Series, Weight)

Example:

WildersADX (JO, 0.071428571)

“WildersADX” Sec Series Weight
WildersADX (HO, 0.071428571)

WildersADXR
Returns an exponentially smoothed version of the WildersADX study discussed above.

WildersADXR (Series, Weight)

Example:

WildersADXR (CME.DB, 0.071428571)
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“WildersADXR” Series Weight
WildersADXR (HO, 0.071428571)

WildersDIMinus
Returns a momentum indicator typically used to identify downtrend directional behavior in the market
and developed by Welles Wilder. This study is calculated by dividing the exponentially Positive Directional
Movement (those days when the difference between today’s low minus the previous day’s low is greater than
the difference between today’s high minus the previous day’s high) by the smoothed True Range.

WildersDIMinus (Series, Weight)

Example:

WildersDiMinus ( DS, 0.071428571)

“WildersDIMinus” Series Weight
WildersDIMinus (HO, 0.071428571)

WildersDIPlus
Returns a momentum indicator typically used to identify up-trend directional behavior in the market and
developed by Welles Wilder. This study is calculated by dividing the exponentially smoothed Positive
Directional Movement (those days when the difference between today’s high minus the previous day’s high is
greater than the difference between today’s low minus the previous day’s low) by the smoothed True Range.

WildersDIPlus (Series, Weight)

Example:

WildersDIPlus ( CNDL, 0.071428571)

“WildersDIPlus” Series Weight
WildersDIPlus (HO, 0.071428571)

WildersDX
WildersDX returns the equivalent to Welles Wilder’s Directional Movement equation. This calculation divides
the difference between DI+ and DI- (true directional movement) and sum of DI+ and DI- (total percentage
of directional movement), and then multiplies this value by 100%.
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The directional movement index (DX) is thus an accounting or a scoring between 0 - 100 of the power of the
trend, be the trend up or down, a high score means the market is strongly trending (up or down) and a low
score bespeaks of weak or no trend.

WildersDX (Series, Weight)

Example:

WildersDX (BO, 0.071428571)

“WildersDX” Series Weight
WildersDX (BO, 0.071428571)

WildersRSI
Returns the Welles Wilder’s Relative Strength Index indicator, a popular overbought-oversold measure. This
study is very similar to simple_rsi, except Wilder’s version uses a form of exponential smoothing where
simple_rsi uses a simple moving average.

This study compares the relative strength of prices gains (closes that are higher than the previous day’s close)
versus price losses (closes that are lower than the previous day’s close) by using an exponentially smooth
average of these values for some specified period of time.

Like simple_rsi, wilders_rsi may be performed for any time period. Wilder originally suggested 14 days,
however, technicians sometimes prefer a shorter/more sensitive period of time such as 5 or 7 days. This study
will range between 0 and 100.

Industry standards derive the overbought and oversold indicators at levels that range around 70 (overbought)
and 30 (oversold).

WildersRSI (Series, Weight)

Example:

WildersRSI (Close of MSFT, 0.095)

“WildersRSI” Attribute of Series Weight
WildersRSI (Close of HO, 0.095)

WilliamsVolAD
Returns the Larry Williams Volume Accumulation-Distribution indicator.

WilliamsVolAD (Security, TimePeriod)
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Example:

WilliamsVolAD (HU, 17 days)

“WilliamsVolAD” Sec Series Constant (Number) Time Period (day/mth/yr)
WilliamsVolAD (HO, 17 days)
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Index

Symbols
% Move, 57
_2x16Average, 88
_2x8Average, 87
_5x16Average, 89
_5x8Average, 89
_7x16Average, 91
_7x8Average, 90
_CoolingDegreeDays, 84
_HeatingDegreeDays, 85
_OffPeakAverage, 86
_OnPeakAverage, 86

A
Absolute Value, 58
AccDist, 92
Actual Prices, 17
Adjust Contract, 13, 14, 58
Adjusted Prices, 17
Always Force 7 Day Trading Pattern, 34
Aspect, 92
AspectEquatorial, 93
AspectHelio, 93
AspectPlot, 93
Average, 61

B
BackContract, 95
Backward Adjusted Prices, 17
Backwards Adjusted Prices, 16
BlackScholesOptionPrice, 95
Bollinger High/Bollinger Low, 62
Built-ins, 57

C
Cash Adjusted Prices, 17
Category, 25
ChannelIndex, 95
Chart Label, 13, 21, 23, 25
Chart Options, 10

Controls, 42
Grid, 42
Legend, 42
Symbols, 42

Chart Type, 5, 13, 21, 25
Charting, 33, 36, 41
Charts, 1
ChoppinessIndex, 96
Column, 5, 13, 23, 25, 48
Compound_return, 62
Configuration Window, 3
Construct Date, 62
Controls, 10, 42
Copy table results to clipboard, 35
Coregression, 63
Coregression_intercept, 64
Coregression_slope, 64
Correlation, 65
Count, 66
Covariance, 66
Currency Conversion, 1
Curve

Description, 23
MIM Symbol, 23

Curves, 23
Column, 23
Curve Date, 23
Edit Chart Stats, 23

D
Data Builder, 3, 4, 7

Curves, 23
Date and Worksheet Options, 29
Formulas, 21
Forward Curves, 25
Series, 13

Date Format, 34
Date Offset, 16
Date Options, 29

Change Period, 29
End, 29
Start, 29

DeferredContract, 96
DeMarker, 96
Description, 5, 39, 49
Desktop/Excel, 33, 35
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DirMove, 98
DirMoveIdx, 99
Dividend Adjusted Return, 66

E
Ease of Move, 67
Edit Axis Config, 32
Edit Chart Stats, 19, 21
Edit Menu, 10

Cut/Copy/Paste, 10
Edit Rollover

Options, 14
Execution Units, 30, 30, 32
Exit, 9
Expiration Day, 16
Expiration Month, 16
Exponential Average, 67
Expression, 49
Extract Day, 68
Extract Month, 68
Extract Year, 68

F
Factor, 13
FarContract, 99
File Menu, 9

Exit, 9
Print Table, 9
Save Table As, 9
XML Converter, 9

Fill Backward, 26, 31
Fill Down, 27
Fill Forward, 31, 31
Fill Linear Interpolation, 26
Fill Up, 27
Fill Vertical Interpolation, 27
First Notice Day, 16
Formula, 21
Formula Specifications, 48

Description, 49
Expression, 49
Relation, 48
Relation Column, 49
Trade Pattern, 49

Formula Table, 57
Formula Variables

Chart Type, 5
Column, 5
Description, 5
Forumla, 5
Label, 5
MIM Symbol, 5
Time Units, 5
Units, 5

Formulas, 2, 21
for Built-ins, 57

Forward Adjusted Prices, 17
Forward Curve Parameters, 26

Aggregate, 26
Date, 26
Fill, 26
Offset, 28

Forward Curves, 1, 25
Category, 25
Chart Label, 25
Chart Type, 25
Column, 25
Description, 25
Precision, 25
Show in Chart, 25
Show in Table, 25

FrontContract, 100

G
Greatest Integer, 69
Grid, 42

H
Help Menu, 11

About, 11
Java Console, 11

Highest, 69
HistVolLog, 101
HistVolPct, 102

I
If-Then Statement, 69
Import Item as Formula, 47
Import Item as Variable, 47
Include Average of Yearly Data, 34
Inverse Log, 70
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L
Last Data Day, 16
Legend, 10, 42
Linear Regression, 70
Lock, 13
Lock Units of Measure by Default, 34
Lowest, 71

M
Macd_osc, 71
Macd_signal, 72
Median, 72
Mid_point, 73
Midpoint, 73
MIM Schema Browser, 47
MIM Symbol, 5, 13
MIMIC Toolbar, 4
Missing Data NaNs, 30
Modify Prices, 19
MoneyFlowIndex, 102
Move, 57, 73

N
Natural Log, 73
Nearest Integer, 74
Negative Value, 74
NegHedgersPct, 103
NegVolIndex, 102
Net Change, 74
Net Percent Change, 75
NetHedgers, 103
NetLargeSpecs, 103
NetLargeSpecsPct, 104
NetSmallTraders, 104
NetSmallTradersPct, 104
NormalDist, 105

O
On Balance Volume, 75
Open Interest Crossover, 16, 16
Options Menu, 11

Axis Font, 11
Color Configuration, 11
Color Print, 11
Mixed Case Symbols, 11
Server Config, 11

User Preferences, 11

P
Periods in Range, 75
Perpetual, 17
PlotAspectX, 94
Positive Value, 76
Precision, 13, 21, 25
Presets, 16

#Day(s) Before Expiration, 16
Backwards Adjusted Prices, 16
Open Interest Crossover, 16
Volume Crossover, 16

Print Table, 9
Printing, 35
Product, 76

R
Range, 76
RangeExpIndex, 105
RealSum, 105
Rel Strength, 77
Rollover Date, 16
Rollover policy, 14
Rows

Copying, 6
Pasting, 6
Repositioning, 6
Right-Click Menu, 6

S
Save Chart As, 9
Save Graphic As, 34
Save Table As, 9
Screening, 36
Searching, 7, 37

by Description, 39
by Symbol, 38
Search Options, 40

Seasonal Analysis, 1, 29, 29
Edit Axis Config, 32
Execution Units, 32
Missing Data NaNs Options, 30

Select Contract, 77
Send New Worksheet/past command to Excel, 35
Send Paste Command to Excel, 35
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Series, 13
Adjust Contract, 13
Chart Label, 13
Chart Type, 13
Column, 13
Description, 13
Factor, 13
Lock, 13
MIM Symbol, 13
Precision, 13
Show in Table/Chart, 13
Time Units, 13
Units, 13

Server Macros, 84
Show Chart Controls, 36
Show Grids, 36
Show in Chart, 21
Show in Table, 21, 25
Simple_rsi, 80
Skip all NaN, 29
Smallest Integer, 80
Smoothed, 18
Standard Deviation, 81
Standard Deviation Population, 81
Stochastics, 106
Stored Formulas, 47
Stream Semantics, 34
Sum, 82
Symbol

Column, 48
Time Units, 48
Units of Measure, 48

Symbol Information, 48
Symbols

Exporting, 9
Importing, 9

T
Table Summary Stats, 29
Table Tab, 35
Tables, 1, 43
Tools Menu, 11

Curve Matrix, 11
Validate Formulas, 11

Tree View, 37
Trendline, 107

Trendlines, 42
True Midpoint, 82
True Range, 82

U
Units, 1, 5
Use 800x600 Pixel Mode, 34
Use description as chart label, 36
User Preferences, 33

Charting, 36
Desktop/Excel, 35
Printing, 35
Screening, 36

V
Variance, 83
View Menu, 10

Chart, 10
Chart Options, 10
Configuration, 10
Query, 10
Table, 10

Volatility, 107
VolatilityIdx, 108
VolPriceTrend, 107
Volume Crossover, 16

W
Wilders_rsi, 83
WildersADX, 108
WildersADXR, 108
WildersDIMinus, 109
WildersDIPlus, 109
WildersDX, 109
WildersRSI, 110
Williamsr, 84
WilliamsVolAD, 110
Worksheet, 4, 5

Shortcuts, 6
Synchronizing, 6

Worksheet Toolbar, 5

Z
Zoom, 42
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